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About this book

Document description

This installation guide provides information on how to install and configure
the IBM® WebSphere® Commerce - Express Developer Edition. It is intended
for developers or system administrators who are using the WebSphere
Commerce - Express Developer Edition to develop store-front assets and
back-office business logic to run with WebSphere Commerce - Express.

Updates to this book

To learn about last-minute changes to the product, refer to the README file
in the root directory of the WebSphere Commerce - Express Developer Edition
CD 1. In addition, a copy of this book, and any updated versions of this book,
are available as PDF files from the Technical Library section of the WebSphere
Commerce Web site:

[http://www.ibm.com/software/commerce/library/|

For additional support information, see the WebSphere Commerce Support
site:

[rttp://www.ibm.com/software/commerce/support/|

Updated versions of this book are also available from the WebSphere
Commerce Zone at WebSphere Developer Domain which is at the following
Web site:

[rttp://www.ibm.com/websphere/developer/zones/commerce|

Updates from the last version of this document are identified by revision
characters contained in the margin. This book uses the following conventions
for revision characters:

* The "+" character identifies updates that have been made in the current
version of this document.

e The " 1" character identifies any updates that have been made in the
previous versions of this document.

Conventions and terminology used in this book
This book uses the following highlighting conventions:

Boldface type Indicates commands or graphical user interface (GUI) controls
such as names of fields, icons, or menu choices.
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Monospace type Indicates examples of text you enter exactly as shown, file
names, and directory paths and names.

Italic type Used to emphasize words. Italics also indicate names for which
you must substitute the appropriate values for your system.

host_name The fully qualified host name of WebSphere Commerce -
Express Developer Edition server (for example,
serverl.torolab.ibm.com is fully qualified).

instance_name The name of WebSphere Commerce - Express Developer
Edition instance with which you are working.

This icon marks a Tip - additional information that can help you
complete a task.

Important
’(These sections highlight especially important information.

Attention
’(These sections highlight information intended to protect your data.

This book uses the following terms:

back-office business logic
The part of your store that customers do not see. Back-office business
logic includes WebSphere Commerce - Express commands, data beans,
enterprise beans

development machine
The machine onto which you install WebSphere Commerce - Express
Developer Edition to develop store-front assets or back-office business
logic for WebSphere Commerce - Express.

store data
The information for a store that supports all customer activities. Store
data includes catalog information, shipping charge information, and
inventory information.

store-front assets
The part of your store with which your customers interact. Store-front
assets include HTML pages, JSP files, style sheets, images, graphics,
and other multimedia file types that define the layout and content of
your Web pages.
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Path variables

This guide uses the following variables to represent directory paths:

DB2_installdir
This is the installation directory for DB2 Universal Database = Express
Edition. The default installation directory for DB2 Universal Database
Express Edition installed by WebSphere Commerce - Express
Developer Edition installation wizard is C:\WebSphere\SQLLIB.

WCDE_installdir
This is the installation directory for WebSphere Commerce - Express
Developer Edition. The default installation directory for WebSphere
Commerce - Express Developer Edition is
C:\WebSphere\CommerceDev55.

WCDE_workspacedir
This is the directory for the WebSphere Commerce - Express
Developer Edition workspace. The default WebSphere Commerce -
Express Developer Edition workspace directory is
C:\WebSphere\workspace_db2.

WSAD_installdir
This is the installation directory for WebSphere Studio Application
Developer. The default installation directory for WebSphere Studio
Application Developer is C:\WebSphere\Studio5.

Knowledge requirements

This book should be read by developers or system administrators who are
installing WebSphere Commerce - Express Developer Edition to develop
store-front assets and back-office business logic to run with WebSphere
Commerce - Express.

Developers or system administrators who are installing and configuring
WebSphere Commerce - Express Developer Edition should have knowledge in
the following areas:

+ Microsoft® Windows® 2000 Server Edition or Advanced Server Edition
 IBM DB2 Universal Database Express Edition
* Basic SQL commands

This knowledge should include how to complete administration and
configuration tasks for the operating system and database server.

Developers who are developing store-front assets or back-office business logic
with WebSphere Commerce - Express Developer Edition should have
knowledge in the following areas:

+ IBM WebSphere Commerce - Express
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* IBM WebSphere Studio Application Developer
* IBM DB2 Universal Database Express Edition
* Java ' programming language

+ Enterprise JavaBeans'component architecture
* JavaServer Pages technology

* HTML

* XML
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Part 1. Introduction

The chapters in this section give a basic description of WebSphere Commerce -
Express Developer Edition, and describe the prerequisite hardware, software,
and user authorities required to complete a successful installation of
WebSphere Commerce - Express Developer Edition. Ensuring that your
system meets all the requirements stated in these chapters will significantly
improve the ease with which your installation is completed. Read this section
thoroughly before attempting to install WebSphere Commerce - Express
Developer Edition.

To learn about last-minute changes to the product, refer to the README file in
the root directory of WebSphere Commerce - Express Developer Edition CD 1.

Important
If you are upgrading from a previous version of WebSphere Commerce -
Express Developer Edition, please read the WebSphere Commerce - Express
Developer Edition Migration Guide before performing the upgrade.
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Chapter 1. Welcome to WebSphere Commerce - Express
Developer Edition

This book describes how to install and configure the WebSphere Commerce -
Express Developer Edition. It is intended for developers or system
administrators who are using the WebSphere Commerce - Express Developer
Edition to develop stores and WebSphere Commerce - Express application
code.

Customized Java code developed in WebSphere Commerce - Express
Developer Edition can only be deployed to a WebSphere Commerce - Express
application.

For instructions on the installation and configuration of WebSphere Commerce
- Express, refer to WebSphere Commerce - Express Installation Guide for Windows
2000

Products included with WebSphere Commerce - Express Developer Edition

The following products and components are packaged with WebSphere
Commerce - Express Developer Edition:

* WebSphere Studio Application Developer, Version 5.1, with the following
plug-ins and toolkits:

— WebSphere Commerce - Express workspace for WebSphere Studio

— WebSphere Commerce - Express Configuration Manager plug-in for
WebSphere Studio

— WebSphere Commerce - Express online help plug-in for WebSphere
Studio

— WebSphere Commerce - Express API reference information plug-in for
WebSphere Studio

WebSphere Studio Application Developer also includes an integrated

WebSphere test environment.

* IBM DB2 Universal Database Express Edition, Version 8.1.2 (DB2 Universal
Database Express Edition, Version 8.1 with fix pack 2)

Note: All references to DB2 Universal Database in this book refer to DB2
Universal Database Express Edition.
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Supported configurations

WebSphere Commerce - Express Developer Edition, its components and its
supported software can be installed in a variety of configurations. The
following configurations are supported and are covered in this book:

* ["WebSphere Commerce - Express Developer Edition using a local database”|

* ["WebSphere Commerce - Express Developer Edition using a remote

database” |

* ["WebSphere Commerce - Express and WebSphere Commerce - Express|
Developer Edition’]

* ["WebSphere Commerce Payments and WebSphere Commerce - Express|
Developer Edition’]

WebSphere Commerce - Express Developer Edition using a local
database
In this configuration, WebSphere Commerce - Express Developer Edition and
the WebSphere Commerce - Express Developer Edition database are installed
on the same machine.

WebSphere Commerce - Express Developer Edition using a remote
database
In this configuration, WebSphere Commerce - Express Developer Edition and
the WebSphere Commerce - Express Developer Edition database are installed
on separate machines. This configuration requires you to install a database
client on the machine on which you install WebSphere Commerce - Express
Developer Edition and the database server on the remote machine.

The WebSphere Commerce - Express Developer Edition only supports remote
databases running on Windows.

WebSphere Commerce - Express and WebSphere Commerce - Express
Developer Edition

WebSphere Commerce - Express Developer Edition and WebSphere Commerce
- Express can be installed on the same system with some restrictions. Refer to
“WebSphere Commerce - Express Developer Edition and WebSphere|
Commerce - Express coexistence” on page 86| for more information.

WebSphere Commerce Payments and WebSphere Commerce - Express
Developer Edition
WebSphere Commerce Payments can run on the same machine as WebSphere
Commerce - Express Developer Edition or a separate machine regardless of
where the WebSphere Commerce - Express Developer Edition database is
located.
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For more information on WebSphere Commerce Payments and WebSphere
Commerce - Express Developer Edition, refer to [Chapter 12, “Configuring|
payment processing in WebSphere Commerce - Express Developer Edition,”]

on page 45.|
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Chapter 2. Planning your WebSphere Commerce - Express
Developer Edition installation

Developing for a Linux or Windows DB2 Universal Database production

environment

For development targeting a production environment running DB2 Universal
Database on Linux or Windows, you must use DB2 Universal Database
running on Windows.

Database management systems running on operating systems other than
Windows are not supported by WebSphere Commerce - Express Developer
Edition.

Developing for an 0S/400® DB2 Universal Database production environment

© Copyright IBM Corp. 1996, 2003

If you are developing code for an OS/400 DB2 Universal Database production
environment, you should plan to develop and test against DB2 Universal
Database running on Windows. When you are ready to deploy your code to
the iSeries” environment, use the WebSphere Commerce - Express EJB
conversion tool to convert EJB meta-data from the workstation flavor of DB2
Universal Database to the iSeries flavor.

More information about deploying code to a production environment is
provided in WebSphere Commerce Programming Guide and Tutorials.
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Chapter 3. Before you install WebSphere Commerce -
Express Developer Edition

Before you install WebSphere Commerce - Express Developer Edition, do the
following;:

1. Ensure that your machine meets the pre-installation requirements listed in
[‘Pre-installation requirements.”|

2. Gather the information required to complete the WebSphere Commerce -
Express Developer Edition installation wizard. Refer to [Chapter 4, “Quick
freference to user IDs and other information,” on page 13

3. Stop any applications running on your machine. You will need to restart
your machine during the installation process, which can cause running
applications to lose data.

Pre-installation requirements

Before installing WebSphere Commerce - Express Developer Edition, ensure
that your machine meets the following hardware and software prerequisites.

Prerequisite hardware

In addition to the requirements for the installation of WebSphere Commerce -

Express, you must ensure that you meet the following minimum hardware

requirements before installing WebSphere Commerce - Express Developer

Edition:

* You require a dedicated Pentium® III 733 MHz IBM-compatible personal
computer with the following:

— A minimum of 1 GB of random access memory (RAM).
— 4.6 GB of hard drive space broken down as follows:

- 1.25 GB of temporary hard drive space required on the C: drive during
the installation. This temporary hard drive space can be broken down
as follows:

* 950 MB of temporary hard drive space required for installing
WebSphere Studio Application Developer.

* 300 MB of temporary hard drive space required for installing
WebSphere Studio Application Developer fixes.

If 1.25 GB of temporary hard drive space is not available, you can
reduce the free space requirements by following the instructions in
[Chapter 11, “Installing WebSphere Commerce - Express Developer]|
Edition on systems with less than 1 GB of temporary hard drive

© Copyright IBM Corp. 1996, 2003 9



kspace,” on page 41|After completing these instructions, the temporary
hard drive space requirements are reduced to 300 MB.

- WebSphere Commerce - Express Developer Edition: 740 MB
- WebSphere Studio Application Developer: 1.5 GB
- WebSphere Commerce - Express Workspace: 600 MB
- DB2 Universal Database Express Edition: 500 MB
Using a remote DB2 Universal Database removes this space

requirement from the WebSphere Commerce - Express Developer
Edition machine.

— A CD-ROM drive.

- A graphics-capable monitor with a color depth of at least 256 colors,
with screen resolution set to 800x600 or higher.

— A mouse or other pointing device.

— A local area network (LAN) adapter that is supported by the TCP/IP
protocol.

Prerequisite software

You must ensure that you meet the following minimum software requirements
before installing WebSphere Commerce - Express Developer Edition:

* Ensure that you have Windows 2000 Professional Edition, Server Edition, or
Advanced Server Edition installed with Service Pack 3 applied.

* Install Microsoft Internet Explorer 6.0 Service Pack 1 or higher with the
latest critical security updates, on the machine(s) you will use to access
WebSphere Commerce - Express Developer Edition. Internet Explorer is
available as a download from Microsoft at the following Web site:
[http://www.microsoft.con

Prior versions of Internet Explorer do not support full functionality of
WebSphere Commerce - Express tools.

 Attention
The default configuration of Internet Information Services (IIS) installed
by default with Windows 2000 Server Edition and Advanced Server
Edition uses port 80 for HTTP. Running IIS on port 80 will prevent the
WebSphere Commerce - Express server from starting within the
WebSphere test environment. Either uninstall or disable IIS on the
WebSphere Commerce - Express Developer Edition machine or change
the HTTP port to a port other than port 80 to correct this problem.

Network configuration requirements

In addition to the hardware and software requirements , ensure that the
network configuration of the system meets the following requirements:
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* The system must have a resolvable domain name.

The host name combined with the domain name is the fully qualified host
name. For example, if the host name is system1 and the domain is ibm.com®,
the fully qualified host name is system1.ibm.com.

Issuing the following command from a command prompt session should
return the IP address of the system:

nslookup 'fully qualified_host_name'

The desired result is a reply with the correct IP address of the system.

* The IP address on the system must resolve to a host name (including a
domain). To determine if the IP address is mapped to a fully qualified host
name, start a command prompt session and issue the following command:

nslookup 'IP_address'

The desired result is a reply with the correct fully qualified host name of
the system.

* Ensure that the system can be reached from other computers in the network
by pinging the fully-qualified host name of the machine on which you are
installing WebSphere Commerce - Express Developer Edition.

Chapter 3. Before you install WebSphere Commerce - Express Developer Edition 11
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Chapter 4. Quick reference to user IDs and other

information

The WebSphere Commerce - Express Developer Edition installation wizard
prompts you for a number of different user IDs and other information in
order to complete the installation. Before starting your installation of
WebSphere Commerce - Express Developer Edition, fill in the following table
so you will have the information handy when you complete the WebSphere
Commerce - Express Developer Edition installation wizard:

User IDs

Review the descriptions in [“User IDs required to complete thel

finstallation wizard” on page 14| then fill in this table:

User ID description User ID

Password

Local Windows user 1D

Database administrator ID

WebSphere Commerce - Express
Developer database user ID

Site Administrator ID

Other information

Review the descriptions in [“Other information required to complete]

the installation wizard” on page 16| then fill in this table:

Other information

Your value

WebSphere Commerce - Express Developer
Edition instance name (optional)

Remote database server host name (remote
database install only)

Remote database server port (remote
database install only)

WebSphere Commerce - Express Developer
Edition database name (optional)

Merchant key

WebSphere Commerce Payments instance
password

© Copyright IBM Corp. 1996, 2003

13



User IDs required to complete the installation wizard

To complete the installation of WebSphere Commerce - Express Developer
Edition, you will need the following IDs defined:

database user
1D

User ID Description
Local To install WebSphere Commerce - Express Developer Edition, the user
Windows ID must have Administrative authority.
user ID
If your Windows user ID does not have Administrator authority or is
more than 20 characters in length, or is not defined on the local
machine, you will be notified of the problem and will not be able to
proceed with the installation.
Database This is the Windows user ID for the database administrator. This ID
administrator | must be defined on the local machine. IDs defined on a Windows
1D domain server are not supported by the WebSphere Commerce -
Express Developer Edition installation program.
This Windows ID can be the same as the user ID used to install
WebSphere Commerce - Express Developer Edition.
Ensure that this Windows user ID has Administrator authority.
WebSphere This is the Windows user ID for a database user that WebSphere
Commerce - | Commerce - Express Developer Edition will use to access the database
Express during development.
Developer
Edition If you have created a Windows user ID for the database user other

than the database administrator, you can use that Windows user ID.
Otherwise, use the same Windows user ID as the database
administrator user ID.

Ensure that this Windows user ID has Administrator authority.

Site
Administrator
1D

This ID is used to access the WebSphere Commerce tools such as the
WebSphere Commerce - Express Accelerator, the WebSphere
Commerce - Express Administration Console, and the WebSphere
Commerce - Express Organization Administration Console.

This is not an operating system ID. This ID is created by the
WebSphere Commerce - Express Developer Edition installation
wizard.
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User ID Description

Site WebSphere Commerce - Express requires that the Site Administrator
Administrator | password adhere to the following rules:
password * Must be at least 8 characters in length.

¢ Must contain at least one numeric character (0-9)
* Must contain at least one alphabetic character (a—z, A-Z)
» Cannot contain four consecutive occurrences of a character

* The same character cannot appear more than 3 times in the
password.

Notes for DB2 Universal Database users:

1. Windows IDs must be defined on the local machine. IDs defined on a

Windows domain server are not supported by the WebSphere Commerce -
Express Developer Edition installation program.

For installing WebSphere Commerce - Express Developer Edition with a
local database, all user IDs can be the same ID on the local machine.

The database administrator ID and database user ID must meet DB2
Universal Database user ID requirements outlined in [‘DB2 Universal]
[Database user ID requirements.”|

DB2 Universal Database user ID requirements

DB2® requires that the user IDs and passwords for database administrators
and database users adhere to the following rules:

They cannot be more than 20 characters in length.
They can contain only the characters Ato Z,atoz 0to9, @ # $, and _.
They cannot begin with an underscore (_).

The user ID cannot be any of the following, in upper, lower, or mixed case:
USERS, ADMINS, GUESTS, PUBLIC, LOCAL.

The user ID cannot begin with any of the following in upper, lower, or
mixed case: IBM, SQL, SYS.

The user ID cannot be the same as any Windows service name.

The user ID must be defined on the local machine, and belong to the Local
Administrator’s group.

The user ID must have the Act as part of the operating system advanced user
right. Restart the computer after having granted this user right.

Refer to your Windows documentation for instructions on setting user
rights.

Chapter 4. Quick reference to user IDs and other information 15



Other information required to complete the installation wizard

To complete the installation of WebSphere Commerce - Express Developer
Edition, you will need to know the following additional information:

Edition instance
name (optional —
a default
instance name is
provided)

Information Description

WebSphere The is the name of the WebSphere Commerce - Express Developer
Commerce - Edition instance.

Express

Developer The default instance name is Demo_Dev.

Remote database
server host name

This is the TCP/IP host name of the remote database server
machine.

This is required only when installing WebSphere Commerce -
Express Developer Edition with a remote database.

Remote database
server port

This is the port number on which the remote database server
listens for connections from clients.

The default port is 50000.

This is required only when installing WebSphere Commerce -
Express Developer Edition with a remote database.

WebSphere
Commerce -
Express
Developer
Edition database
name (optional —
a default
database name is
provided)

This is the name of the WebSphere Commerce - Express Developer
Edition database.

The default database name is Demo_Dev.
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Information

Description

Merchant key

The merchant key is a 16-digit hexadecimal number that meets the
following criteria:

* Must contain at least one numeric character (0-9)

* Must contain at least one alphabetic character (a—f)
Important: Upper-case letters are not valid in the merchant key.

* Cannot contain four consecutive occurrences of a character

A hexadecimal number can only contain the following numbers
and letters: 0, 1,2, 3,4,5,6,7,8,9,a b,c,d e f

The merchant key is used by the WebSphere Commerce - Express
Configuration Manager as an encryption key. You must enter your
own key in the Merchant key field. Ensure that the key that you
enter will be sufficient to protect your site. After you have created
a store you can only change this key by using the Database
Update Tool. To use this tool, access Configuration Manager,
navigate to the database node for the WebSphere Commerce
instance, right-click on the database node, and select Run
Database Update Tool.

WebSphere
Commerce
Payments
instance
password

This is the password used by WebSphere Commerce Payments to
connect to the WebSphere Commerce Payments database and
decrypt any sensitive data that is stored in the database.

This password will be specified when issuing the IBMPayServer
command when starting WebSphere Commerce Payments. For
more details, refer to |‘Starting and stopping WebSphere|
[Commerce Payments” on page 73|

The WebSphere Commerce Payments instance password must
meet the following criteria:

* Must be at least 8 characters in length.

* Must contain at least one numeric character (0-9)

¢ Must contain at least one alphabetic character (a-z, A-Z)

» Cannot contain four consecutive occurrences of a character

* The same character cannot appear more than 3 times in the
password.
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Part 2. Installing WebSphere Commerce - Express
Developer Edition

The chapters in this section describe how to install WebSphere Commerce -
Express Developer Edition.

Review [Chapter 2, “Planning your WebSphere Commerce - Express Developer]
[Edition installation,” on page 7|before installing WebSphere Commerce -
Express Developer Edition.

To install WebSphere Commerce - Express Developer Edition, complete the
tasks in one of the following sections:

* [Chapter 5, “Installing WebSphere Commerce - Express Developer Edition|
with a local database,” on page 21|

* [Chapter 6, “Installing WebSphere Commerce - Express Developer Edition|
with a remote database,” on page 23]

After completing either of those sections, complete the tasks in[Chapter 7]
[“Installing WebSphere Commerce - Express Developer Edition,” on page 25)

Note: This part describes how to install WebSphere Commerce - Express
Developer Edition using the CDs provided with the product box. If you
copy one or more of the CDs to a network for the purposes of
installing from a network drive, it is recommended that you do not
change the names of the folders, paths, and directories that are on the
CDs. During the installation process, if you are prompted for a
component or CD, you must specify the location of the component,
which is the top level directory on the CD.

You must use mapped network drives when installing WebSphere
Commerce - Express Developer Edition from a network. UNC paths are
not supported by the installation wizard.

Important information for iSeries developers: Using WebSphere Commerce -
Express Developer Edition with a remote database on iSeries is not supported.
To develop for WebSphere Commerce - Express running on iSeries, use
WebSphere Commerce - Express Developer Edition with a local DB2 database
and then use the supplied tools to deploy any developed code to the iSeries
machine.

Information about deploying code to an iSeries machine from a WebSphere
Commerce - Express Developer Edition machine is provided in WebSphere
Commerce Programming Guide and Tutorials.
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Chapter 5. Installing WebSphere Commerce - Express
Developer Edition with a local database

In this configuration, WebSphere Commerce - Express Developer Edition and
the WebSphere Commerce - Express Developer Edition database are installed
on the same machine.

Using DB2 Universal Database as the local WebSphere Commerce - Express
Developer Edition database

When you use DB2 Universal Database as the local WebSphere Commerce -
Express Developer Edition database, no additional steps are required. DB2
Universal Database is installed and the WebSphere Commerce - Express
Developer Edition database is created and configured as part of the
WebSphere Commerce - Express Developer Edition installation.

The next step

After completing the instructions in this chapter, proceed with your
installation of WebSphere Commerce - Express Developer Edition by
following the instructions in [Chapter 7, “Installing WebSphere Commerce -|
[Express Developer Edition,” on page 25
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Chapter 6. Installing WebSphere Commerce - Express
Developer Edition with a remote database

In this configuration, WebSphere Commerce - Express Developer Edition and
the WebSphere Commerce - Express Developer Edition database are installed
on different Windows machines. Databases on operating systems other than
Windows are not supported by WebSphere Commerce - Express Developer
Edition.

Using DB2 Universal Database as the remote WebSphere Commerce - Express
Developer Edition database

When you use DB2 Universal Database as the remote WebSphere Commerce -
Express Developer Edition database, you must install DB2 Universal Database
on a Windows system before installing WebSphere Commerce - Express
Developer Edition. To install DB2 Universal Database as the WebSphere
Commerce - Express Developer Edition database, do the following:

1. Install DB2 Universal Database on the remote machine.

2. On the remote DB2 Universal Database server machine, check that an
entry similar to the following exists in the services file:
db2c_DB2 50000/tcp #connection port

The services file can be found in the following directory:
C:\winnt\system32\drivers\etc

After completing these steps, continue with the instructions in Ehapter 7,|
[“Installing WebSphere Commerce - Express Developer Edition,” on page 25)
The WebSphere Commerce - Express Developer Edition database is created
and configured as part of the WebSphere Commerce - Express Developer
Edition installation. You can also choose to use an existing WebSphere
Commerce - Express Developer Edition, Version 5.5 database during the
installation.

The next step

After completing the instructions in this chapter, proceed with your
installation of WebSphere Commerce - Express Developer Edition by
following the instructions in|Chapter 7, “Installing WebSphere Commerce -|
[Express Developer Edition,” on page 25.|
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Chapter 7. Installing WebSphere Commerce - Express
Developer Edition

To install WebSphere Commerce - Express Developer Edition, you must be
logged in as a user with Administrator authority.

Note: If you have either an HTTP Server or WebSphere Application Server
installed on the machine on which you want to install WebSphere
Commerce - Express Developer Edition, ensure that the HTTP server
and WebSphere Application Server are not running before installing
WebSphere Commerce - Express Developer Edition.

The machine on which you are installing WebSphere Commerce -
Express Developer Edition requires 1.25 GB of temporary hard drive
space on the C: drive during the installation.

If 1.25 GB of temporary hard drive space is not available, you can
reduce the free space requirements by following the instructions in
Chapter 11, “Installing WebSphere Commerce - Express Developer]|
Edition on systems with less than 1 GB of temporary hard drive
space,” on page 41 After completing these instructions, the
temporary hard drive space requirements are reduced to 300 MB.

To install WebSphere Commerce - Express Developer Edition, do the
following:

1. Review the information in [Chapter 2, “Planning your WebSphere|
[Commerce - Express Developer Edition installation,” on page 7[to ensure
that you have selected the correct configuration to install.

2. Complete the tasks in|Chapter 3, “Before you install WebSphere|
[Commerce - Express Developer Edition,” on page 9.

3. Do one of the following, depending on the type of database program you
are using for WebSphere Commerce - Express Developer Edition
database:

+ Complete the steps in ["Using DB2 Universal Database as the local|
WebSphere Commerce - Express Developer Edition database” on pagel
21,

« Complete the steps in [“Using DB2 Universal Database as the remote
WebSphere Commerce - Express Developer Edition database” on pagel
23,

4. Insert WebSphere Commerce - Express Developer Edition CD 1 into the
CD-ROM drive.
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If the installation program does not automatically start, launch the
setup.exe program located at the root of the CD.

5. Select the language you want to use during the install and click OK.
A check is performed to ensure that the system meets the pre-installation
requirements.
If your system meets the pre-installation requirements the Welcome page
displays.
If your system does not meet the pre-installation requirements, a dialog
box will open detailing the requirements which have not been met. Click
Cancel and then Exit Setup to exit the installation program. Take the

appropriate steps to meet the pre-installation requirements which were
listed and begin the installation again.

6. If your system meets the pre-installation requirements, the Welcome page
displays. Click Next to continue.

7. The Software License Agreement page displays. Review the terms of the
license agreement in the Software License Agreement page.

If you accept the terms of the license agreement, click Accept to accept
the terms of the license agreement and continue installing WebSphere
Commerce - Express Developer Edition.

If you decline the terms of the license agreement, click Decline. Declining
the terms of the license agreement exits the WebSphere Commerce -
Express Developer Edition install program.

8. If you have accepted the terms of the license agreement, the WebSphere
Commerce - Express Developer Instance Information page displays. Enter
the following information:

* WebSphere Commerce - Express Developer instance name
* Merchant key

* WebSphere Commerce Payments instance password

* Site Administrator ID

* Site Administrator password

Descriptions of these items can be found in [Chapter 4, “Quick reference]
[to user IDs and other information,” on page 13.| Ensure that the merchant
key and WebSphere Commerce Payments instance password meet all the
requirements listed in that section.

Click Next to continue.

9. The WebSphere Commerce - Express Developer Database Information
page displays. Complete the fields on this page as follows:

WebSphere Commerce - Express Developer database name
Enter the name of the WebSphere Commerce - Express Developer
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database. A description of this item can be found in thapter 4,|
[“Quick reference to user IDs and other information,” on page 13}

Development database type
As WebSphere Commerce - Express Developer Edition only
supports DB2 Universal Database Express Edition, no selection
can be made here.

If an edition of DB2 Universal Database other than IBM DB2
Universal Database Express Edition Version 8.1.2 (Version 8.1
with fix pack 2) is detected, you will receive an error message.
Exit the installation wizard and change the edition of DB2
Universal Database to IBM DB2 Universal Database Express
Edition Version 8.1.2 before restarting the installation wizard.

Create WebSphere Commerce - Express Developer database
Clear or select this check box as follows:

 If you want to create a new WebSphere Commerce - Express
Developer Edition database, ensure this check box is selected.

During the install, the WebSphere Commerce - Express
Developer Edition and WebSphere Commerce Payments
databases are created and populated.

If a database called Demo_Dev or wpm already exists, ensure that
you do not use the database user ID for the existing database
as the database user ID entered into the installation wizard
later on.

* If you want to use an existing WebSphere Commerce - Express
Developer Edition database, ensure this check box is cleared.

When using an existing WebSphere Commerce - Express
Developer Edition database, ensure that the database name in
the WebSphere Commerce - Express Developer Edition
database name field matches the name of the existing
WebSphere Commerce - Express Developer Edition database.
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— Attention
If you choose to use an existing WebSphere Commerce -
Express Developer Edition database, the WebSphere
Commerce Payments instance will not be created by the
installation wizard.

WebSphere Commerce Payments does not support using an
existing WebSphere Commerce Payments database.

The WebSphere Commerce Payments instance must be
created manually if you choose to use an existing database.
Instructions for creating a WebSphere Commerce Payments
instance manually are provided in [‘Creating a WebSphere
[Commerce Payments instance” on page 64

Use remote WebSphere Commerce - Express Developer database
Clear or select this check box as follows:

* To use WebSphere Commerce - Express Developer Edition with
a local database, ensure this check box is cleared.

* To use WebSphere Commerce - Express Developer Edition with
a remote database, ensure this check box is selected.

When you have completed all the fields, click Next to continue.

10. The next WebSphere Commerce - Express Developer Database
Information page displays. Enter the following information:

* Database administrator ID
* Database administrator password
* Database user ID

* Database user password

Descriptions of these items can be found in [Chapter 4, “Quick reference]
[to user IDs and other information,” on page 13.Click Next to continue.

11. If you selected the Use remote WebSphere Commerce - Express
Developer Edition database check box, the Remote Database Information
page displays. Enter the following information:

e Database server host name
* Database server port

Descriptions of these items can be found in |Chapter 4, “Quick referencel
[to user IDs and other information,” on page 13]

Click Next to continue.
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12.

13.

14.

15.

The Choose Destination page displays. You can accept the default
destination paths or change them. Click Next to continue installing
WebSphere Commerce - Express Developer Edition.

Note: Due to limitations on the length of environment variables, the
destination paths must be no more than two directories deep. For
example: C:\WebSphere\CommerceDev55. If the destination paths
are too deep, the CLASSPATH environment variable will exceed
the 256 character limit for Windows environment variables. An
incorrect CLASSPATH environment variable will adversely affect
the function of WebSphere Commerce - Express Developer Edition.

The Documentation Language Selection page displays. Select the
languages in which you want the WebSphere Commerce - Express
Developer Edition online documentation available. Click Next to continue
installing WebSphere Commerce - Express Developer Edition.

The Summary page displays. Review the installation options to ensure
they are correct, then click Next.

The installation wizard continues by installing and configuring the
WebSphere Commerce - Express Developer Edition components.
Follow the prompts and replace the CD in the CD-ROM drive with the

CD the prompt requests. The number of times you will need to change
CDs depends on the number of components that must be installed.

The installation wizard does the following:

Installing WebSphere Studio Application Developer, if required.
If WebSphere Studio Application Developer, Version 5.1 is already
installed on the machine, this step is skipped.

Installing DB2 Universal Database, if required.
This step is skipped if any of the following are true:
* IBM DB2 Universal Database Express Edition Version 8.1.2 is
already installed on the machine.

* You chose to use an existing WebSphere Commerce - Express
Developer Edition, Version 5.5 database.

Installing the DB2 Universal Database Administration Client, if required
This step only occurs if you are using DB2 Universal Database as
the WebSphere Commerce - Express Developer Edition database
and you selected Use remote WebSphere Commerce - Express
Developer Edition database in the installation wizard.

This step is skipped if the DB2 Universal Database
Administration Client is detected on the machine.

Installing WebSphere Commerce - Express Developer Edition
The installation wizard installs any remaining WebSphere
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Commerce - Express Developer Edition components and
WebSphere Commerce Payments.

Note: WebSphere Commerce Payments is always installed by the
installation wizard. It is not an optional component in the
development environment.

Creating the WebSphere Commerce - Express Developer Edition instance.
After successful creation of the WebSphere Commerce - Express
Developer Edition instance, a dialog displays.

If the instance creation fails you can manually create a
WebSphere Commerce - Express Developer Edition instance by
following the instructions in [“Creating a WebSphere Commerce -|
[Express Developer Edition instance” on page 63

Click OK to dismiss the dialog and continue the installation.

Creating the WebSphere Commerce Payments instance.
This step is skipped if you cleared the Create WebSphere
Commerce - Express Developer Edition database check box. In
this case, you must create the WebSphere Commerce Payments
instance manually.

After successful creation of the WebSphere Commerce Payments
instance, a dialog displays.

If the instance creation fails you can create a WebSphere
Commerce Payments instance manually by following the
instructions in [‘Creating a WebSphere Commerce Payments|
finstance” on page 64/

Click OK to dismiss the dialog and continue the installation.

Importing the WebSphere Commerce - Express workspace into WebSphere Studio
Application Developer
After the WebSphere Commerce - Express workspace imports
successfully, a dialog displays indicating the location of the
workspace import log. Click OK to dismiss the dialog and
continue the installation.

Installing the WebSphere Application Server fixes required by the WebSphere
test environment
These fixes allow you to successfully run WebSphere Commerce
in the WebSphere test environment.

16. The installation of WebSphere Commerce - Express Developer Edition is
complete when the Reboot Computer dialog displays. Remove the CD
from the CD-ROM drive and select whether you will reboot the
WebSphere Commerce - Express Developer Edition machine now or later.

Click Finish to exit the installation wizard.
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You must reboot the WebSphere Commerce - Express Developer Edition
machine before verifying that the installation of WebSphere Commerce -
Express Developer Edition was successful. To verify that the installation of
WebSphere Commerce - Express Developer Edition was successful, follow the
instructions in |Chapter 8, “Verifying your installation,” on page 33.|

During the installation, the WebSphere Commerce - Express Developer Edition
creates and populates the following directory:

C:\WCTemp

You may delete this directory after completing the installation.

The next step
After completing the instructions in this chapter, do the following:

1. Verify the installation of WebSphere Commerce - Express Developer
Edition by following the instructions in [Chapter 8, “Verifying your|
finstallation,” on page 33)

2. Complete the mandatory post-installation tasks outlined in
[‘Mandatory post-installation tasks,” on page 37
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Chapter 8. Verifying your installation

As the WebSphere Commerce - Express Developer Edition installation
progresses, log files are generated. These log files contain messages indicating
a successful installation or where errors occurred during a failed installation.

Verify your installation of WebSphere Commerce - Express Developer Edition
by examining the following log files:

+ ['DB2 Universal Database installation log.”|

* ["WebSphere Studio Application Developer log files” on page 34.]

* ["WebSphere Commerce - Express Developer Edition workspace import log”|

on page 34.|

* ["WebSphere Commerce - Express Developer Edition instance creation logs’]

on page 35.|

* ["WebSphere Commerce - Express Developer Edition fix installation log” on|

page 36.|

* ["WebSphere Commerce - Express Developer Edition installation log” onl
page 36.|

If all of these logs indicate success, your installation of WebSphere Commerce
- Express Developer Edition was successful.

DB2 Universal Database installation log

Examine the DB2 Universal Database install log if you chose to install
WebSphere Commerce - Express Developer Edition with a local DB2 Universal
Database. Otherwise, verify your WebSphere Commerce - Express Developer
Edition installation by examining the other log files discussed in this section.

This log contains messages generated during the installation of DB2 Universal
Database. The default location for this log file is:

C:\WINNT\db2wi.log

DB2 Universal Database installed successfully if the last line in the log file
contains the following text:

Product: DB2 Universal Database Express Edition --
Installation operation completed successfully.

This message has been formatted for this book. In the log file, the message
appears as a single line.
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WebSphere Studio Application Developer log files

Check the following directory for the existence of log files:
WSAD_installdir/1ogs

If the installation of WebSphere Studio Application Developer was successful,
this directory will contain the following log file:

licence.log

If the last line of this log file contains the following text, you have a valid
license installed for WebSphere Studio Application Developer:

You have valid Ticense

If the WSAD_installdir/logs directory contains the Install.log file, the
installation of WebSphere Studio Application Developer was unsuccessful.
Examine the log file carefully to find the errors that occurred during
installation.

WebSphere Commerce - Express Developer Edition workspace import log

After creating a WebSphere Commerce - Express Developer Edition instance,
the installation imports the WebSphere Commerce - Express Developer Edition
workspace into WebSphere Studio Application Developer.

The workspace import log file is located in the following path:
WCDE_installdir\logs\import workspace.log

The default value for WCDE_installdir is listed in[“Path variables” on page v

The WebSphere Commerce - Express Developer Edition workspace was
imported into WebSphere Studio Application Developer successfully if there
are no exceptions listed in the file for each project that was imported and the
following message appears near the end of the file:

BUILD SUCCESSFUL

The workspace import log file has one line for each project imported in the
section starting with importProjects:. The line for each project begins with
[importProject]. A project is imported successfully if no exceptions appear in
the log file after the [importProject] line for the project. If any exceptions
occurred while a project was being imported, the project must be imported
manually. Refer to [“Importing a project manually” on page 80| for instructions.
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WebSphere Commerce - Express Developer Edition instance creation logs

Instance creation during the WebSphere Commerce - Express Developer
Edition installation creates the following log files:

* auction.log

* createdb.log

¢ createdb.production.log
* createdb_db2.log
* createsp.log

* createsp.errlog

* populatedb.err.log
* populatedbx.err.log
* populatedb.log

* populatedbx.log

* populatedbnl.log

* populatedbnl.err.log
* reorgdb2.log

¢ reorgdb2.err.log

* trace.txt

where x is a number.

The files are located in the following directory:
WCDE_installdir\Commerce\instances\instance_name\1o0gs

where instance_name is the name of WebSphere Commerce - Express
Developer Edition instance.

Instance creation is successful if the following logs are empty:
* createsp.errlog

* populatedb.err.log

* populatedbx.err.log

* populatedbnl.err.log

* reorgdb2.err.log

Also, review the contents of the following logs to confirm they do not contain
any errors:

* createdb.log
* createdb_db2.log
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If instance creation failed, the WebSphere Commerce - Express Developer
Edition instance can be created manually by following the instructions in
“Creating a WebSphere Commerce - Express Developer Edition instance” on|

page 63.|

WebSphere Commerce - Express Developer Edition fix installation log

The WebSphere Commerce - Express Developer Edition fix installation log
contains a summary of the fix installation process and is located in the
following path:

WCDE_installdir\1ogs\wcWASefixer.log

The default value for WCDE_installdir is listed in|“Path variables” on page v

The WebSphere Commerce - Express Developer Edition fixes installed
successfully if the following message appears at the end of the file:

Fix installation completed successfully.

WebSphere Commerce - Express Developer Edition installation log

The WebSphere Commerce - Express Developer Edition installation log
contains a summary of the overall installation process and is located in the
following path:

WCDE_installdir\1ogs\WCDEInstall.log

The default value for WCDE_installdir is listed in|“Path variables” on page v/

The WebSphere Commerce - Express Developer Edition installation is
complete if the following message appears at the end of the file:

WebSphere Commerce-Express Developer Edition Setup Complete

The next step

After completing the instructions in this chapter, complete the mandatory
post-installation tasks outlined in [Chapter 9, “Mandatory post-installation|
[tasks,” on page 37] These steps include:

* Updating the data source information for the WebSphere Commerce -
Express server in WebSphere Studio Application Developer by following the
instructions in [“Updating the WebSphere Commerce - Express server datal
kource” on page 37

36  WebSphere Commerce - Express Developer Edition Installation Guide



Chapter 9. Mandatory post-installation tasks

After installing WebSphere Commerce - Express Developer Edition and
verifying that the installation was successful, you must complete the following
tasks before using WebSphere Commerce - Express Developer Edition:

1. ["Applying required software updates to WebSphere Commerce - Express|
Developer Edition”]

2. ["Updating the WebSphere Commerce - Express server data source.”]

Failure to complete these tasks will result in an inability to run WebSphere
Commerce - Express and WebSphere Commerce Payments in the WebSphere
test environment.

Applying required software updates to WebSphere Commerce - Express
Developer Edition

After you have successfully installed WebSphere Commerce - Express
Developer Edition, review the README file in the root directory of WebSphere
Commerce - Express Developer Edition CD 1. The README file will
document any fixes (if any are required) that need to be applied to WebSphere
Commerce - Express Developer Edition and its component software, such as
WebSphere Studio Application Developer.

Failure to install any documented fixes will cause WebSphere Commerce -
Express Developer Edition to function incorrectly.

Updating the WebSphere Commerce - Express server data source

Before you can start the WebSphere Commerce - Express server in the
WebSphere test environment, you must update the WebSphere Commerce -
Express server data source with the correct database user password.

To update the WebSphere Commerce - Express server data source, do the
following:

1. Start WebSphere Commerce - Express Developer Edition by selecting Start
» Programs » IBM WebSphere Commerce - Express Developer Edition -
WebSphere Commerce development environment.

2. In the J2EE Hierarchy view of the J2EE Perspective, expand Servers and
double-click WebSphereCommerceServer. The
WebSphereCommerceServer view displays.

3. In the WebSphereCommerceServer view, select the Data source page.

4. On the Data sources page, expand Server Settings.
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9.

In the JDBC provider list table, select the following:
DB2 JDBC Driver

After selecting a JDBC provider, the tables below the JDBC provider list
table update.

In the Data source defined in the JDBC provider selected above table,
select the following:
jdbc/WebSphere Commerce DB2 DataSource instance_name

where instance_name is the name of the WebSphere Commerce - Express
Developer Edition instance. The default instance name is Demo_Dev.

Click Edit. The Modify Data Source wizard starts.

In the Modify Data Source wizard, replace any value in the Default user
password field with the password for the ID shown in the Default user
ID field. The user ID and password should be the database user ID and
password described in |[Chapter 4, “Quick reference to user IDs and other|
finformation,” on page 13.]

Click Finish to update the information and close the Modify Data Source
wizard.

Save the updates to the configuration by selecting File + Save.

Note: Updating the WebSphere Commerce Payments server data source is not

required.

The next step

After completing the instructions in this chapter, complete any of the optional
configuration tasks, including:

Chapter 10, “Optional post-installation tasks,” on page 39

Chapter 12, “Configuring payment processing in WebSphere Commerce —|
Express Developer Edition,” on page 45|

Chapter 13, “Configuring WebSphere Studio Application Developer logging]
tools,” on page 53|

[Chapter 14, “Publishing the Express Store sample store,” on page 55|

Chapter 15, “Publishing the FashionFlow sample store in WebSphere|
Commerce - Express Developer Edition,” on page 57|

Chapter 16, “Configuring additional WebSphere Commerce - Express|
software for WebSphere Commerce - Express Developer Edition,” on page]
59
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Chapter 10. Optional post-installation tasks

After completing the mandatory post-installation tasks, you can complete any
of the optional post-installation tasks including the following:

* [‘Reducing memory requirements for DB2 Universal Database’]

Reducing memory requirements for DB2 Universal Database

WebSphere Commerce - Express Developer Edition installs DB2 Universal
Database with default buffer pool values. These values may be higher than
those required by your development environment.

To reduce the memory requirements for DB2 Universal Database, do the
following;:

1. Ensure that you are logged in as the DB2 database administrator.

2. Start the DB2 Command Line Processor by selecting Start + Programs »
IBM DB2 » Command Line Tools » Command Line Processor.
3. Enter the following commands:

connect to WCDE_database_name user DBZ2_admin_ID using DBZ_admin_pwd
alter bufferpool IBMDEFAULTBP size 1000

alter bufferpool BUFF8K size 50

alter bufferpool BUFF16K size 50

alter bufferpool BUFF32K size 50

where the variables are defined as follows:

WCDE_database_name
The name of the WebSphere Commerce - Express Developer
Edition database.

The default name of the database created by the WebSphere
Commerce - Express Developer Edition installation wizard is
Demo_Dev.

DB2_admin_ID
The ID for the DB2 Universal Database administrator.

DB2_admin_pwd
The password associated with the DB2 Universal Database
administrator.

4. Close the DB2 Command Line Processor.
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The next step

After completing the instructions in this chapter, complete any of the optional
configuration tasks, including:

* [Chapter 12, “Configuring payment processing in WebSphere Commerce -|
Express Developer Edition,” on page 45|

* (Chapter 13, “Configuring WebSphere Studio Application Developer logging]
tools,” on page 53|

* [Chapter 14, “Publishing the Express Store sample store,” on page 55|

* [Chapter 16, “Configuring additional WebSphere Commerce - Express|
software for WebSphere Commerce - Express Developer Edition,” on page
59
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Chapter 11. Installing WebSphere Commerce - Express
Developer Edition on systems with less than 1 GB of
temporary hard drive space

If the machine on which you are installing WebSphere Commerce - Express
Developer Edition has less than 1 GB of temporary space available on the C:
drive, do the following:

1. Install WebSphere Studio Application Developer on the WebSphere
Commerce - Express Developer Edition machine by following the
instructions in the IBM WebSphere Studio Application Developer, Version 5.1
Installation Guide (install.pdf) in the root of WebSphere Studio
Application Developer CD 1.

2. Install WebSphere Commerce - Express Developer Edition by following the
instructions in |[Chapter 7, “Installing WebSphere Commerce - Express|
[Developer Edition,” on page 25/

When WebSphere Studio Application Developer is installed before WebSphere
Commerce - Express Developer Edition, the requirement for 1 GB of available
temporary space on the C: drive no longer applies.
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Part 3. Configuring WebSphere Commerce - Express
Developer Edition

The chapters in this section describe how to perform any of the optional
configurations for WebSphere Commerce - Express Developer Edition beyond
the initial configuration when you install WebSphere Commerce - Express
Developer Edition. Topics covered in this section include:

Chapter 12, “Configuring payment processing in WebSphere Commerce -|
Express Developer Edition,” on page 45|

Chapter 13, “Configuring WebSphere Studio Application Developer logging]
tools,” on page 53|

[Chapter 14, “Publishing the Express Store sample store,” on page 55|

Chapter 15, “Publishing the FashionFlow sample store in WebSphere|
Commerce - Express Developer Edition,” on page 57|

Chapter 16, “Configuring additional WebSphere Commerce - Express|
software for WebSphere Commerce - Express Developer Edition,” on page
59
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Chapter 12. Configuring payment processing in
WebSphere Commerce - Express Developer Edition

To test a store based on a WebSphere Commerce - Express sample store, you
should be able to complete an entire shopping flow, including completing a
purchase.

To complete a purchase in the Express Store sample store, WebSphere
Commerce Payments is not required.

For more information on the Express Store, refer to WebSphere Commerce -
Express Easy Start Guide.

To complete a purchase in the FashionFlow sample store, the development
environment must be configured to use one of the following payment
processing methods:

* WebSphere Commerce Payments on the development machine.
¢ WebSphere Commerce Payments on a remote machine

For more information on the FashionFlow sample store, refer to WebSphere
Commerce Sample Store Guide.

Installing WebSphere Commerce - Express Developer Edition creates a
WebSphere Commerce Payments instance on the development machine. The
development environment is initially configured to use this local WebSphere
Commerce Payments instance. Depending on your development requirements
you may want to change the development environment configuration to not
use WebSphere Commerce Payments or use WebSphere Commerce Payments
on a remote machine.

Configuring the development environment to use WebSphere Commerce
Payments on the development machine

WebSphere Commerce Payments is configured on the development machine
when WebSphere Commerce - Express Developer Edition is installed. After
installing WebSphere Commerce - Express Developer Edition, you must
configure payment methods in WebSphere Commerce Payments. For more
details, refer to [‘Configuring accepted payment methods in WebSphere
[Commerce Payments” on page 50/
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To use WebSphere Commerce Payments in the WebSphere test environment,
start WebSphere Commerce Payments according to the instructions in
[“Starting and stopping WebSphere Commerce Payments” on page 73]

If you want to configure the development environment to use WebSphere
Commerce Payments on a remote machine, follow the instructions in
“Configuring the development environment to use WebSphere Commerce]
Payments on a remote machine” on page 47|

If you have configured the development environment to use WebSphere
Commerce Payments on a remote machine and you want to return to using
WebSphere Commerce Payments on the development machine, follow the
instructions in [“Switching from remote WebSphere Commerce Payments tof
[local WebSphere Commerce Payments.”|

Switching from remote WebSphere Commerce Payments to local
WebSphere Commerce Payments

If you have configured the development environment to use WebSphere
Commerce Payments on a remote machine and you want to return to using
WebSphere Commerce Payments on the development machine, do the
following:

1. If you are running WebSphere Commerce - Express in the WebSphere test
environment, stop WebSphere Commerce - Express. For detailed
instructions, refer to|”Stopping WebSphere Commerce - Express” on pagel
73]

2. Start Configuration Manager. For detailed instructions, refer to |”Startina
[WebSphere Commerce - Express Configuration Manager” on page 71]

3. In the navigation area, expand WebSphere Commerce - Express -
host_name » Commerce » InstanceList » instance_name »
InstanceProperties, then select Payments.
where host_name is the TCP/IP host name of the machine running
WebSphere Commerce - Express Developer Edition and instance_name is
the name of WebSphere Commerce - Express Developer Edition instance.
The default WebSphere Commerce - Express Developer Edition instance is
Demo_Dev.

4. Fill in the fields on the Payments page as follows:
Hostname
Enter the fully qualified host name of the WebSphere Commerce -

Express Developer Edition machine. Do not use localhost in this
field.

Profile Path
Ensure the path is the following:

WCDE_installdir/Commerce/instances/instance_name/xm1/payment
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where instance_name is the name of WebSphere Commerce -
Express Developer Edition instance.

Use non-SSL Payments Client
Ensure this box is not selected.

Webserver Port
Enter 5433.

Use Socks Server
Ensure this check box is not selected.

Socks Hostname
This field should be disabled because the Use Socks Server check
box is not selected.

Socks Port Number
This field should be disabled because the Use Socks Server check
box is not selected.

Click Apply. If the changes are applied successfully, a message displays.
Click OK to dismiss the message.

Stop Configuration Manager. For detailed instructions, refer to[“Stopping]
[WebSphere Commerce - Express Configuration Manager” on page 72|

Configuring the development environment to use WebSphere Commerce
Payments on a remote machine

Before you can configure your development environment to use a remote
WebSphere Commerce Payments, you must install and configure WebSphere
Commerce Payments on a machine separate from your development machine.

To configure the development environment to use WebSphere Commerce
Payments on a remote machine, do the following:

1.

Install and configure WebSphere Commerce Payments on the remote
machine. For more instructions, refer to|“Installing and configuring|
[WebSphere Commerce Payments” on page 48]

Configure the WebSphere Commerce - Express Developer Edition instance
to use a remote WebSphere Commerce Payments. For more details, refer to
‘Configuring a WebSphere Commerce - Express Developer Edition|
instance to use a remote WebSphere Commerce Payments” on page 49.|

Configure payment methods in WebSphere Commerce Payments. For more
details, refer to|“Configuring accepted payment methods in WebSphere]
[Commerce Payments” on page 50)

If you have configured the development environment to use WebSphere
Commerce Payments on a remote machine and you want to return to using
WebSphere Commerce Payments on the development machine, follow the
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instructions in [“Switching from remote WebSphere Commerce Payments tol
[local WebSphere Commerce Payments” on page 46

Installing and configuring WebSphere Commerce Payments

To install and configure WebSphere Commerce Payments on a machine
separate from your development machine, do the following:

1. Complete a custom installation of WebSphere Commerce - Express on the
remote machine. During the installation, select the following components
when completing the custom installation:

* WebSphere Commerce Payments, including WebSphere Application
Server base product

* IBM HTTP Server, including WebSphere Application Server plug-in
Instructions for completing a custom installation are provided in WebSphere
Commerce - Express Installation Guide.

2. Create a WebSphere Commerce Payments instance by following the
instructions in WebSphere Commerce - Express Installation Guide.

Ensure that you enter the fully qualified host name of the WebSphere
Commerce - Express Developer Edition machine in the WC Hostname
field of the WCSRealm panel of the Payments Instance Creation wizard.

Also, ensure that you use specify a unique database name — if the
database name already exists, instance creation will fail. The default name
for the WebSphere Commerce Payments database is WPM.

3. Start IBM HTTP Server according to the IBM HTTP Server documentation.

4. Start WebSphere Commerce Payments by following the instructions in
WebSphere Commerce - Express Installation Guide.

5. Ensure that you can connect to WebSphere Commerce Payments from the
WebSphere Commerce - Express Developer Edition machine by opening
the following URL:

http://host_name:5432/webapp/PaymentManager

or

https://host_name:5433/webapp/PaymentManager

where the variables are defined as follows:

host_name
The fully qualified TCP/IP host name of the Web server associated
with WebSphere Commerce Payments. In this case, it would be the
same host name as the WebSphere Commerce Payments machine.

If WebSphere Commerce Payments is SSL-enabled, use the secure (https)
URL. Otherwise, use the non-secure (http) URL.

48 WebSphere Commerce - Express Developer Edition Installation Guide



If you see the IBM WebSphere Commerce Payments Logon page, your
configuration of the remote WebSphere Commerce Payments machine was
successful.

Configuring a WebSphere Commerce - Express Developer Edition
instance to use a remote WebSphere Commerce Payments

To configure your instance to use a remote WebSphere Commerce Payments,

do the following on your WebSphere Commerce - Express Developer Edition

machine:

1. If you are running WebSphere Commerce - Express in the WebSphere test
environment, stop WebSphere Commerce - Express. For detailed
instructions, refer to [“Stopping WebSphere Commerce - Express” on page|

2. Start Configuration Manager. For detailed instructions, refer to |”Starting_;|
[WebSphere Commerce - Express Configuration Manager” on page 71]

3. In the navigation area, expand WebSphere Commerce - Express -
host_name » Commerce » InstanceList » instance_name »
InstanceProperties, then select Payments.

where host_name is the TCP/IP host name of the machine running
WebSphere Commerce - Express Developer Edition and instance_name is
the name of WebSphere Commerce - Express Developer Edition instance.
The default WebSphere Commerce - Express Developer Edition instance is
Demo_Dev.

4. Hill in the fields on the Payments page as follows:

Hostname
Enter the fully qualified host name of the WebSphere Commerce
Payments machine. This field defaults to the WebSphere
Commerce - Express Developer Edition host name. If you have
installed WebSphere Commerce Payments on a remote machine,
you must ensure that this field contains the fully qualified host
name of the WebSphere Commerce Payments machine. If
WebSphere Commerce Payments and the Web server it uses are on
separate machines then enter the fully qualified host name of the
Web server machine.

Profile Path
The full path name of the directory where the standard WebSphere
Commerce - Express WebSphere Commerce Payments Cashier
Profiles are to be stored. The default value is:

WCDE_installdir/Commerce/instances/instance_name/xm1/payment

where instance_name is the name of WebSphere Commerce -
Express Developer Edition instance.
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Use non-SSL Payments Client
Select this check box if you want WebSphere Commerce - Express
Developer Edition to use the non-Secure Sockets Layer (SSL)
WebSphere Commerce Payments client to communicate with the
WebSphere Commerce Payments server. This allows the
WebSphere Commerce - Express Server in the WebSphere test
environment to communicate with WebSphere Commerce
Payments without using SSL.

Webserver Port
Enter the TCP port number of the Web server that WebSphere
Commerce Payments uses. If you have enabled Use non-SSL
WebSphere Commerce Payments client the default value for this
field is 5432. If this check box has not been selected, the default
value for this field is 5433 (the SSL port).

Use Socks Server
Enable this check box if WebSphere Commerce - Express
Developer Edition must go through a socks server in order to
reach WebSphere Commerce Payments.

Socks Hostname
Enter the fully-qualified host name of your socks server. This field
is only available if the Use Socks Server check box is enabled.

Socks Port Number
Enter the port number that your socks server uses. This field is
only available if the Use Socks Server check box is enabled.
5. Click Apply. If the changes are applied successfully, a message displays.
Click OK to dismiss the message.

6. Stop Configuration Manager. For detailed instructions, refer to
ebSphere Commerce - Express Configuration Manager” on page 72.

Configuring accepted payment methods in WebSphere Commerce Payments

Before enabling the WebSphere Commerce Payments for use with WebSphere
Commerce - Express in the WebSphere test environment you must configure
the payment methods accepted by a store.

When you a publish a sample store, a number of sample payment methods
are automatically configured and the instructions in this section can be
skipped. However, you should complete these steps after publishing a sample
store if you find the sample store does not contain payment methods you
would like to test.

To configure WebSphere Commerce Payments, do the following:
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1. Ensure that the WebSphere Commerce Payments server is started. For
instructions on starting the WebSphere Commerce Payments server, refer
to [“Starting WebSphere Commerce Payments” on page 73

2. Ensure that the WebSphere Commerce - Express server is started. For
instructions on starting the WebSphere Commerce - Express server, refer
to [“Starting WebSphere Commerce - Express” on page 72/

3. Log in to WebSphere Commerce Payments using the Site Administrator
user ID and password. You can access the WebSphere Commerce
Payments log in page by entering the following URL in a browser:

http://host_name:5432/webapp/PaymentManager

or
https://host_name:5433/webapp/PaymentManager

where the variables are defined as follows:

host_name
The fully qualified TCP/IP host name of the Web server
associated with WebSphere Commerce Payments. If you are
running WebSphere Commerce Payments in the WebSphere test
environment, host_name is the fully qualified TCP/IP host name
of the WebSphere Commerce - Express Developer Edition
machine.

If WebSphere Commerce Payments is SSL-enabled, use the secure (https)
URL. Otherwise, use the non-secure (http) URL.

If you see the IBM WebSphere Commerce Payments Logon page, your
configuration of the WebSphere Commerce Payments machine was
successful.

4. From the left panel, click Merchant Settings.

5. Click Refresh to see what merchant was added after you have published
a sample store.

6. In the right window, click Add a Merchant.
7. Enter a Merchant Name for your sample store. The Merchant Number
must be the same as the storeld for your sample store (e.g. 10001). Select

the OfflineCard check box and click Create Merchant. A "Merchant
created successfully” message should appear.

Note: If a merchant already exists for your storelD, you cannot create
another merchant for the same storelD.
8. In the left panel, click Merchant Settings again. In the right hand
window, beside the name of your new merchant, the green cassette status
icon (under the OfflineCard column) indicates that the OfflineCard
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cassette is enabled and running for that merchant. Click the green icon.
You must now create an account for each currency supported by your
store, by clicking Accounts.

9. Click Add an Account. Enter an Account Name and an Account Number.
The account number must be unique within that store. Select the
appropriate currency from the drop-down menu. Click Create Account.

10. In the Accounts window, click the name of your new account, then click
Brands.

11. Click Add a Brand. Enter a Brand Name (e.g. VISA) and click Create
Brand.

12. Repeat for all other Brands to be used with this account. Repeat the
above three steps to add accounts for all other currencies to be supported
by your store.
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Chapter 13. Configuring WebSphere Studio Application
Developer logging tools

To use the logging tools available in WebSphere Studio Application Developer
effectively with WebSphere Commerce - Express log files, you must make the
WebSphere Commerce - Express symptom database available to the logging
tools by importing the symptom database into WebSphere Studio Application
Developer.

To import the WebSphere Commerce - Express symptom database into
WebSphere Studio Application Developer, do the following:

1.

10.

© Copyright IBM Corp.

Start WebSphere Commerce - Express Developer Edition by selecting
Start » Programs » IBM WebSphere Commerce - Express Developer
Edition » WebSphere Commerce development environment.

From the Window menu, select Preferences. The Preferences dialog
opens.

In the navigation tree, select Symptom Database. The Symptom Database
view displays.

Click Add URL. The Add URL dialog opens.

Complete the fields in the Add URL dialog as follows:

Symptom database name
WebSphere Commerce

URL

ftp://ftp.software.ibm.com/software/websphere/info/tools/
lToganalyzer/symptoms/wc/symptomdb.xml

This URL is shown on multiple lines for display purposes only.
Enter the URL as one line.

Click OK to dismiss the dialog.
Click Apply to apply the changes.

In the navigation tree of the Preferences dialog, expandProfiling and
Logging » Log View » Symptom Database then select Import Database.
The Import Symptom Database File wizard starts.

In the Import Symptom Database File wizard, select Remote Host and
select WebSphere Commerce from the list of remote hosts.

Complete the remaining fields of the Import Symptom Database File
wizard as follows:

Location
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ftp://ftp.software.ibm.com/software/websphere/info/tools/loganalyzer/symptoms/wc/symptomdb.xml
ftp://ftp.software.ibm.com/software/websphere/info/tools/loganalyzer/symptoms/wc/symptomdb.xml

LogAnalyzerProject
File
wesymptomdb. trcdbxmi
11. Click Finish to import the WebSphere Commerce - Express symptom
database file.
12. Click OK to dismiss the Preferences dialog.
The WebSphere Commerce - Express symptom database is now available to
the logging tools in WebSphere Studio Application Developer. For more
information on the logging tools and how to use them, refer to the WebSphere
Studio Application Developer online help.
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Chapter 14. Publishing the Express Store sample store

For information on publishing and configuring the Express Store in
WebSphere Commerce - Express Developer Edition, refer to WebSphere
Commerce - Express Easy Start Guide.
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Chapter 15. Publishing the FashionFlow sample store in
WebSphere Commerce - Express Developer Edition

To publish the FashionFlow sample store in WebSphere Commerce - Express
Developer Edition, follow the instructions in the "Publishing a store archive”
topic in the WebSphere Commerce Production and Development online help.

For more information on the FashionFlow sample store, refer to WebSphere
Commerce Sample Store Guide.

For instructions on accessing the WebSphere Commerce Production and
Development online help, refer to|“WebSphere Commerce - Express Developer|
[Edition online help” on page 91|

Note: If you refer to instructions for multiple platforms in the["WebSpherd
[Commerce - Express Developer Edition online help” on page 91) ensure
you follow the instructions for WebSphere Commerce - Express
Developer Edition. When a help page contains information for multiple
platforms, information specific to WebSphere Commerce - Express
Developer Edition is indicated with the following icon:

Developer

If information specific to WebSphere Commerce - Express Developer
Edition is not available, ensure you follow instructions specific to
Windows. When a help page contains instructions for multiple
platforms, instructions for Windows are indicated with the following
icon:
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Chapter 16. Configuring additional WebSphere Commerce -
Express software for WebSphere Commerce - Express
Developer Edition

WebSphere Commerce - Express provides additional software packages that
you may want to use in the WebSphere test environment. For more
information on the additional software packages provided with WebSphere
Commerce - Express, refer to WebSphere Commerce - Express Additional Software
Guide.

Use the information in this section, along with WebSphere Commerce - Express
Additional Software Guide, to install and configure the additional software
packages for use with WebSphere Commerce - Express Developer Edition.

Using Lightweight Directory Access Protocol with WebSphere Commerce -
Express Developer Edition

To use Lightweight Directory Access Protocol (LDAP) with WebSphere
Commerce - Express Developer Edition, follow the instructions for using
LDAP with WebSphere Commerce - Express found in WebSphere Commerce -
Express Additional Software Guide with the following changes:

* Launch the WebSphere Commerce - Express Configuration Manager from
within WebSphere Studio Application Developer by following the
instructions in [“Starting WebSphere Commerce - Express Configuration|
[Manager” on page 71]

WebSphere Commerce - Express Analyzer

To use WebSphere Commerce - Express Analyzer with WebSphere Commerce
- Express Developer Edition, do the following:

1. Enable the administration console in WebSphere Commerce - Express
Developer Edition for the WebSphere Commerce - Express application
server by following the instructions in [“Enabling the administration|
fconsole” on page 79.|

2. Follow the instructions found in WebSphere Commerce - Express Additional
Software Guide with the following changes:

* Launch the WebSphere Commerce - Express Configuration Manager
from within WebSphere Studio Application Developer by following the
instructions in [“Starting WebSphere Commerce - Express Configuration|
[Manager” on page 71|
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e Launch WebSphere Commerce - Express according to the instructions in
[“Starting and stopping WebSphere Commerce - Express” on page 72]

* Launch the administration console from within WebSphere Commerce -
Express Developer Edition by following the instructions in [“Starting the

[administration console” on page 79|instead of opening the WebSphere
Application Server Administrative Console.

* Scope changes to the WebSphere Commerce - Express application server
by selecting Server from list of available scopes.

You cannot scope any changes to the WebSphere Commerce - Express
application server by entering the name of the WebSphere Commerce -
Express application server in the Server field as this field is unavailable
when the WebSphere Application Server Administrative Console runs in
the WebSphere test environment.

WebSphere Commerce - Express business integration

The business integration software package described in the WebSphere
Commerce - Express Additional Software Guide, WebSphere MQ, is not provided
with either WebSphere Commerce - Express - Express or the WebSphere
Commerce - Express Developer Edition. It must be purchased separately.

WebSphere MQ

To use WebSphere MQ (formerly MQSeries®) with WebSphere Commerce -
Express Developer Edition, do the following:

1. Enable the administration console in WebSphere Commerce - Express
Developer Edition for the WebSphere Commerce - Express application
server by following the instructions in [“Enabling the administration|
fonsole” on page 79.|

2. Follow the instructions found in WebSphere Commerce - Express Additional
Software Guide with the following changes:

* Skip any steps for starting WebSphere Application Server. Starting
WebSphere Application Server is not required when working in
WebSphere Commerce - Express Developer Edition.

* Skip any steps for starting the WebSphere Application Server node
agent. Starting the WebSphere Application Server node agent is not
required when working in WebSphere Commerce - Express Developer
Edition.

* Launch the administration console from within WebSphere Commerce -

Express Developer Edition by following the instructions in [“Starting the
[administration console” on page 79|instead of opening the WebSphere

Application Server Administrative Console.

* Scope changes to the WebSphere Commerce - Express application server
by selecting Server from list of available scopes.
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You cannot scope any changes to the WebSphere Commerce - Express
application server by entering the name of the WebSphere Commerce -
Express application server in the Server field as this field is unavailable
when the WebSphere Application Server Administrative Console runs in
the WebSphere test environment.

* Do not perform the tasks outlined in "Determining the maximum
number of ManagedConnections for the JCA-JMS connector”.

* Do not change the value in the Max Connections field of the
Connection Pool page for the WebSphere MQ JMS Provider queue
connection factory in the administration console. Accept the default
value.

* Launch the WebSphere Commerce - Express Configuration Manager
from within WebSphere Studio Application Developer by following the
instructions in [“Starting WebSphere Commerce - Express Configuration|
[Manager” on page 71
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Chapter 17. Advanced configurations for WebSphere
Commerce - Express Developer Edition

The development environment installed by WebSphere Commerce - Express
Developer Edition is best suited for developing a single store within a single
WebSphere Commerce - Express Developer Edition instance in a single
workspace. IBM does not recommend having multiple WebSphere Commerce
- Express Developer Edition instances in one workspace.

Creating a WebSphere Commerce - Express Developer Edition instance
To create a WebSphere Commerce - Express Developer Edition instance, do
the following:

1. Start WebSphere Commerce - Express Configuration Manager. For details,
refer to|“Starting WebSphere Commerce - Express Configuration Manager’]

|9n page 71 |

2. In the navigation area, select WebSphere Commerce - Express » host_name
» Commerce » InstanceList.

where host_name is the TCP/IP host name of the machine running
WebSphere Commerce - Express Developer Edition.

3. Select Action » Create instance. The Instance Creation wizard starts.
4. Complete the Instance Creation wizard. For help on completing the panels

and fields in the Instance Creation wizard, click Help on the Instance
Creation wizard.

The help for the Instance Creation wizard is common for all platforms. If a
field requires information unique to WebSphere Commerce - Express
Developer Edition, the information is indicated with this icon:

Developer

If information specific to WebSphere Commerce - Express Developer
Edition is not indicated, use information specific to Windows. Instructions
for Windows are indicated with the following icon:

Information not marked with any icon applies to all platforms equally,
including WebSphere Commerce - Express Developer Edition.

5. When you have completed all the necessary information in all the panels,
the Finish button is enabled. Click Finish to create the WebSphere
Commerce - Express Developer Edition instance.

Depending on the speed of your system, it will take several minutes to
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several hours for your instance to be created. The progress bar that displays

when you start creating the instance will indicate when the process has

finished.

6. When instance creation is complete, a dialog appears containing a
summary. Click OK to dismiss the dialog.

7. Stop Configuration Manager. For detailed instructions, refer to|”Stopping|
[WebSphere Commerce - Express Configuration Manager” on page 72)

8. Verify the creation of the WebSphere Commerce - Express Developer
Edition instance by following the instructions in |“Verifying WebSphere|
[Commerce - Express Developer Edition instance creation.”|

Verifying WebSphere Commerce - Express Developer Edition instance
creation

To verify that the instance has been properly created, check the following files
in the WCDE_installdir\Commerce\instances\WCDE_instance_name directory:

\xm1\WCDE_instance_name .xm]
This file contains all of the configuration information about
WebSphere Commerce - Express Developer Edition instance.

\logs\createdb.log
This file contains information about WebSphere Commerce - Express
Developer Edition database creation.

\Togs\populatedb.log
This file contains information about WebSphere Commerce - Express
Developer Edition database population process .

\Togs\sec_check.log
This file contains information about potential security exposures.

The default value for WCDE_installdir is listed in|“Path variables” on page v

Creating a WebSphere Commerce Payments instance
To create a WebSphere Commerce Payments instance, do the following:

1. Start WebSphere Commerce - Express Configuration Manager. For details,
refer to|“Starting WebSphere Commerce - Express Configuration Manager”]

Ign page 71 |

2. In the navigation area, select WebSphere Commerce - Express » host_name
+ Payments » InstanceList.

where host_name is the TCP/IP host name of the machine running
WebSphere Commerce - Express Developer Edition.

3. Select Action » Create payments instance. The payments instance creation
wizard starts.
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4. Complete the payments instance wizard information. For help on
completing the panels and fields in the instance creation wizard, click
Help on the payments instance creation wizard.

The help for the payments instance creation wizard is common for all
platforms. If a field requires information unique to WebSphere Commerce
- Express Developer Edition, the information is indicated with this icon:

Developer

If information specific to WebSphere Commerce - Express Developer
Edition is not indicated, use information specific to Windows. Instructions
for Windows are indicated with the following icon:

Information not marked with any icon applies to all platforms equally,
including WebSphere Commerce - Express Developer Edition.
5. When you have completed all the necessary information in all the panels,

the Finish button is enabled. Click Finish to create the WebSphere
Commerce Payments instance.

Depending on the speed of your system, it will take several minutes to
several hours for your instance to be created. The progress bar that displays
when you start creating the instance will indicate when the process has
finished.

6. When instance creation is complete, a dialog appears containing a
summary of the instance creation. Click OK to dismiss the dialog.

7. Stop Configuration Manager. For detailed instructions, refer tol”Stoppingl
[WebSphere Commerce - Express Configuration Manager” on page 72/

8. Verify the creation of the WebSphere Commerce Payments instance by
following the instructions in [“Verifying the WebSphere Commerce|
[Payments instance creation.”

To use the new WebSphere Commerce Payments_instance with WebSphere
Commerce - Express Developer Edition, refer to [Chapter 12, “Configuring|
payment processing in WebSphere Commerce - Express Developer Edition,”]

on page 45J
Verifying the WebSphere Commerce Payments instance creation

To verify that the instance has been properly created, check the following files
in the WCDE_installdir\Commerce\instances\payments_instance_name
directory:

\xm1\payments_instance_name .xm1
This file contains all of the configuration information about your
WebSphere Commerce Payments instance.
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\logs\createdb.log

This file contains information about the WebSphere Commerce
Payments database creation.

The default value for WCDE_installdir is listed in|“Path variables” on page v

Deleting a WebSphere Commerce - Express Developer Edition instance

To delete a WebSphere Commerce - Express Developer Edition instance, do
the following:

1.

Stop WebSphere Commerce - Express. For details, refer to pping
[WebSphere Commerce - Express” on page 73)

Start WebSphere Commerce - Express Configuration Manager. For details,
refer to [“Starting WebSphere Commerce - Express Configuration|
[Manager” on page 71.|

In the navigation area, select WebSphere Commerce - Express
host_name » Commerce » InstanceList » instance_name.

where host_name is the TCP/IP host name of the machine running
WebSphere Commerce - Express Developer Edition and instance_name is
the name of the WebSphere Commerce - Express Developer Edition
instance you want to delete.

Select Action » Delete instance. A confirmation dialog displays.

Click Yes to delete the WebSphere Commerce - Express Developer
Edition instance. If the instance deletes successfully, a message displays.
Click OK to dismiss the message.

Stop Configuration Manager. For detailed instructions, refer to |”Stoppiné|
[WebSphere Commerce - Express Configuration Manager” on page 72.]

Drop the WebSphere Commerce - Express Developer Edition database by
following the instructions in [“Dropping a database” on page 68)

Delete the files associated with the deleted WebSphere Commerce -
Express Developer Edition instance by deleting the following directory:

WCDE_installdir\Commerce\instances\instance_name

where instance_name is the name of the deleted WebSphere Commerce -
Express Developer Edition instance and the default value for
WCDE_installdir is listed in[“Path variables” on page v

Delete the following directory, if it exists:

DB2 installdir\function\routine\sqlproc\database _name

database_name is the name of the database for the deleted WebSphere
Commerce - Express Developer Edition instance. Default values for
DB2_installdir are listed in [“Path variables” on page v.|
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10. If you published any stores in the WebSphere Commerce - Express

Developer Edition instance, remove the store files by deleting the
following directory:

WCDE_workspacedir\Stores\Web Content\store name

where WCDE_workspacedir is the directory associated with the workspace
for the instance and store_name is the name of the store. The default
workspace directories are listed in [“Path variables” on page v

Deleting a WebSphere Commerce Payments instance

To delete a WebSphere Commerce Payments instance, do the following:

1.

Stop WebSphere Commerce Payments. For details, refer to pping
[WebSphere Commerce Payments” on page 75

Start WebSphere Commerce - Express Configuration Manager. For details,
refer to|“Starting WebSphere Commerce - Express Configuration Manager’]

|9n page 71 |

In the navigation area, select WebSphere Commerce - Express * host_name
» Payments » Instance List » instance_name.

where host_name is the TCP/IP host name of the machine running
WebSphere Commerce - Express Developer Edition and instance_name is
the name of WebSphere Commerce Payments instance you want to delete.

Select Action » Delete Payments instance. A confirmation dialog displays.
Click Yes to delete the WebSphere Commerce Payments instance. If the

instance deletes successfully, a message displays. Click OK to dismiss the
message.

Stop Configuration Manager. For detailed instructions, refer tol“Stoppingl
[WebSphere Commerce - Express Configuration Manager” on page 72]

Drop the WebSphere Commerce Payments database by following the
instructions in [“Dropping a database” on page 68|

Delete the file associated with the deleted WebSphere Commerce Payments
instance by deleting the following directories, if they exist:

WCDE_installdir\Commerce\instances\instance_name
WCDE_installdir\Commerce\payments\instance name

where instance_name is the name of the deleted WebSphere Commerce
Payments instance and the default value for WCDE_installdir is listed in
[“Path variables” on page v/

Delete the following directory, if it exists:
DB2 installdir\function\routine\sqlproc\database name
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database_name is the name of the database for the deleted WebSphere
Commerce - Express Developer Edition instance. Default values for
DB2_installdir are listed in [“Path variables” on page v

Dropping a database

Follow the instructions appropriate to your WebSphere Commerce - Express
Developer Edition configuration:

* ['Dropping a local database in DB2 Universal Database”|

* ["'Dropping a remote database in DB2 Universal Database”|

Dropping a local database in DB2 Universal Database
To drop a local database in DB2 Universal Database, do the following:

1. Open a DB2 command window by selecting Start + Programs » IBM DB2
+ Command Line Tools »+ Command Line Processor.

2. Enter the following command:
drop db database_name

where database_name is the name of the database for the deleted
WebSphere Commerce - Express Developer Edition or WebSphere
Commerce Payments instance.

Dropping a remote database in DB2 Universal Database

To drop a remote database in DB2 Universal Database, do the following:

1. Open a DB2 command window on the WebSphere Commerce - Express
Developer Edition machine by selecting Start » Programs » IBM DB2 »
Command Window.

2. Enter the following commands:

attach to node_name user db2_admin_id using dbZ2_admin_password
drop db database_name
uncatalog node node_name

where
* node_name is the name of the node for the database_name.

e db2_admin_id is the DB2 database administrator ID on the remote
database.

* db2_admin_password is the password for the DB2 database administrator
ID on the remote database.

* database_name is the name of the database for the deleted WebSphere
Commerce - Express Developer Edition or WebSphere Commerce
Payments instance.

68  WebSphere Commerce - Express Developer Edition Installation Guide



Part 4. Appendixes

© Copyright IBM Corp. 1996, 2003

69



70  WebSphere Commerce - Express Developer Edition Installation Guide



Appendix A. WebSphere Commerce - Express Developer
Edition tasks

This section provides instructions on some common tasks performed while
installing, configuring, and using WebSphere Commerce - Express Developer
Edition. The tasks covered in this section are:

‘Starting and stopping WebSphere Commerce - Express Configuration|

Manager.”|

[‘Starting and stopping WebSphere Commerce - Express” on page 72.|

[‘Starting and stopping WebSphere Commerce Payments” on page 73

[‘Opening the WebSphere Commerce Administration Console” on page 77

‘Opening the WebSphere Commerce Organization Administration Console”)

on page 77.|

[‘Opening the WebSphere Commerce Payments user interface” on page 78|

[‘Opening the WebSphere Commerce Accelerator” on page 78

[‘Enabling the administration console” on page 79

‘Starting the administration console” on page 79.|

‘Importing a project manually” on page 80

Starting and stopping WebSphere Commerce - Express Configuration Manager

Many settings in the WebSphere Commerce - Express Developer Edition
instance are set using the WebSphere Commerce - Express Configuration
Manager. The instructions in this section are for starting and stopping
WebSphere Commerce - Express in the WebSphere test environment. For
instructions on starting and stopping WebSphere Commerce - Express in
WebSphere Application Server, refer to WebSphere Commerce - Express
Installation Guide.

Starting WebSphere Commerce - Express Configuration Manager

To start the WebSphere Commerce - Express Configuration Manager, do the
following:

1. Start WebSphere Commerce - Express Developer Edition by selecting Start

» Programs » IBM WebSphere Commerce - Express Developer Edition »
WebSphere Commerce development environment.

Show the WebSphere Commerce view in WebSphere Studio Application
Developer by doing the following:

a. Open the Show View dialog by selecting Window » Show View -
Other.
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b. In the Show View dialog, expand Other and select WebSphere
Commerce.
c. Click OK to dismiss the Show View dialog and display the WebSphere
Commerce view.
3. In the WebSphere Commerce view, right-click Configuration Manager
Server and select Start server from the pop-up menu.
4. When the status of the Configuration Manager Server is "Started”,
right-click Configuration Manager Server again and select Run client
from the pop-up menu. The Configuration Manager client displays.

Stopping WebSphere Commerce - Express Configuration Manager

To stop the WebSphere Commerce - Express Configuration Manager from

WebSphere Commerce - Express Developer Edition, do the following:

1. Exit the WebSphere Commerce - Express Configuration Manager by
selecting Console » Exit.

2. Go to the WebSphere Commerce view in WebSphere Studio Application
Developer by doing the following:
a. Open the Show View dialog by selecting Window » Show View -

Other.

b. In the Show View dialog, expand Other and select WebSphere
Commerce.

c. Click OK to dismiss the Show View dialog and display the WebSphere
Commerce view.

3. In the WebSphere Commerce view, right-click Configuration Manager
Server and select Stop server from the pop-up menu.

Starting and stopping WebSphere Commerce - Express

The instructions in this section are for starting and stopping WebSphere
Commerce - Express in the WebSphere test environment. For instructions on
starting and stopping WebSphere Commerce - Express in WebSphere
Application Server, refer to WebSphere Commerce - Express Installation Guide.

Starting WebSphere Commerce - Express

To start WebSphere Commerce - Express in the WebSphere test environment,
start the WebSphere Commerce - Express application server by doing the
following:

1. Start WebSphere Commerce - Express Developer Edition by selecting Start
+ Programs » IBM WebSphere Commerce - Express Developer Edition »
WebSphere Commerce development environment.

2. In the Servers view, right-click WebSphereCommerceServer and select Start
from the pop-up menu.
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Check the Console view to ensure that no errors occur as the WebSphere
Commerce - Express application server starts.

The WebSphere Commerce - Express application server is started successfully
if the following message appears in the Console view:

Server serverl open for e-business

However, a successful start of the WebSphere Commerce - Express application
server does not indicate that WebSphere Commerce - Express started
successfully in the WebSphere test environment. To ensure that WebSphere
Commerce - Express started successfully, review the contents of the Console
view to ensure that no errors occurred. If the Console view contains no error
messages, WebSphere Commerce - Express started successfully.

Stopping WebSphere Commerce - Express
To stop WebSphere Commerce - Express in the WebSphere test environment,
stop the WebSphere Commerce - Express application server by doing the
following:
1. Start WebSphere Commerce - Express Developer Edition by selecting Start
> Programs » IBM WebSphere Commerce - Express Developer Edition »
WebSphere Commerce development environment.

2. In the Servers view, right-click WebSphereCommerceServer and select Stop
from the pop-up menu.

Check the Console view to ensure that the WebSphere Commerce - Express
application server stops.

Starting and stopping WebSphere Commerce Payments

The instructions in this section are for starting and stopping WebSphere
Commerce Payments in the WebSphere test environment. For instructions on
starting and stopping WebSphere Commerce Payments in WebSphere
Application Server, refer to WebSphere Commerce - Express Installation Guide.

Starting WebSphere Commerce Payments

To start WebSphere Commerce Payments, do the following;:

1. (Optional) Check if the WebSphere Commerce Payments instance
password is required. For instructions, refer to|“Checking if the WebSphere|
[Commerce Payments instance password is required” on page 76.|

By default, the WebSphere Commerce Payments instance created during
the installation of WebSphere Commerce - Express Developer Edition does
not require the WebSphere Commerce Payments instance password.

You should check if the instance password is required if you are unsure of
the setting.

Appendix A. WebSphere Commerce - Express Developer Edition tasks 73



2. Start the WebSphere Commerce Payments application server in the
WebSphere test environment. For instructions, refer to |”Starting tha
[WebSphere Commerce Payments application server.”|

3. If the WebSphere Commerce Payments instance password is required,
issue the IBMPayServer command. For details, refer to

[BMPayServer command.”|

Starting the WebSphere Commerce Payments application server
To start the WebSphere Commerce Payments application in the WebSphere

test environment, start the WebSphere Commerce Payments application server

by doing the following:

1. Start WebSphere Commerce - Express Developer Edition by selecting Start
+ Programs » IBM WebSphere Commerce - Express Developer Edition »
WebSphere Commerce development environment.

2. In the Servers view, right-click WebSphereCommercePaymentsServer and
select Start from the pop-up menu.

Check the Console view to ensure that no errors occur as the WebSphere
Commerce Payments application server starts.

The WebSphere Commerce Payments application server is started successfully
if the following message appears in the Console view:

Server serverl open for e-business

However, a successful start of the WebSphere Commerce Payments
application server does not indicate that the WebSphere Commerce Payments
application started successfully in the WebSphere test environment. To ensure
that the WebSphere Commerce Payments application started successfully,
review the contents of the Console view to ensure that no errors occurred. If
the Console view contains no error messages, the WebSphere Commerce
Payments application started successfully.

Issuing the IBMPayServer command
The IBMPayServer command is used to specify the WebSphere Commerce

Payments password for connecting to the database and decrypting any
sensitive data that is stored in the database. For more information on the
WebSphere Commerce Payments password, refer to [“WebSphere Commerce
[Payments instance password” on page 76|

To issue the IBMPayServer command, do the following:

1. Open a command prompt.

2. Change directories to the following directory:
WCDE_installdir\Commerce\payments\bin
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The default value for WCDE_installdir is listed in|“Path variables” on pagel

3. Issue the following command:
IBMPayServer instance_name

where instance_name is the name of the WebSphere Commerce Payments
instance that you want to start. The name of the default WebSphere
Commerce Payments instance is wpm.

At the Password prompt, enter the password associated with the database
user ID for the WebSphere Commerce Payments database.
Stopping WebSphere Commerce Payments
To stop WebSphere Commerce Payments, do the following:

1. (Optional) Check if the WebSphere Commerce Payments instance
password is required. For instructions, refer to|’Checking if the WebSphere|
[Commerce Payments instance password is required” on page 76.|

By default, the WebSphere Commerce Payments instance created during
the installation of WebSphere Commerce - Express Developer Edition does
not require the WebSphere Commerce Payments instance password.

You should check if the instance password is required if you are unsure of
the setting.

2. If the WebSphere Commerce Payments instance password is required
issue the StopIBMPayServer command. For more details, refer to
fthe StopIBMPayServer command.”|

3. Stop the WebSphere Commerce Payments application server in the
WebSphere test environment. For instructions, refer to |”Stopping tha
[WebSphere Commerce Payments application server” on page 76|

Issuing the StopIBMPayServer command
To issue the StopIBMPayServer command, do the following;:

1. Open a command prompt.
2. Change directories to the following directory:
WCDE_installdir\Commerce\payments\bin

where the default value for WCDE_installdir is listed in [“Path variables’]

3. Issue the following command:

StopIBMPayServer instance_name

where instance_name is the name of the WebSphere Commerce Payments
instance that you want to stop.
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At the Password prompt, enter the password associated with the database
user ID for the WebSphere Commerce Payments database.

Stopping the WebSphere Commerce Payments application server
To stop the WebSphere Commerce Payments application server in the

WebSphere test environment, do the following;:

1. Start WebSphere Commerce - Express Developer Edition by selecting Start
+ Programs » IBM WebSphere Commerce - Express Developer Edition »
WebSphere Commerce development environment.

2. In the Servers view, right-click WebSphereCommercePaymentsServer and
select Stop from the pop-up menu.

Check the Console view to ensure that the WebSphere Commerce Payments
application server stops.

WebSphere Commerce Payments instance password

WebSphere Commerce Payments requires a password so that it can decrypt
any sensitive data that is stored in the database. Protection of this password is
therefore critical to protecting the security of your payment data. The
IBMPayServer command is used to specify the WebSphere Commerce
Payments instance password. The password is also required when issuing the
StopIBMPayServer command.

The password is the WebSphere Commerce Payments instance password
defined when the WebSphere Commerce Payments instance was created.

You must specify the password directly from the command line after issuing
the IBMPayServer or StopIBMPayServer command.

Checking if the WebSphere Commerce Payments instance password is
required

By default, the WebSphere Commerce Payments instance created during the
installation of WebSphere Commerce - Express Developer Edition does not
require the WebSphere Commerce Payments instance password. You should
check if the instance password is required if you are unsure of the setting.

To check if the WebSphere Commerce Payments instance password is required

when starting WebSphere Commerce Payments from a command line, do the

following:

1. Open the Configuration Manager. For instruction, refer to |”Starting|
[WebSphere Commerce - Express Configuration Manager” on page 71)

2. Expand your host name.
3. Expand Payments.
4. Expand Instance List.
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5. Expand the name of the WebSphere Commerce Payments instance you
want to start. The default WebSphere Commerce Payments instance is wpm.

6. Expand Instance Properties.

7. Select Instance.

If the Password Required for startup check box is selected, you must issue
the IBMPayServer command after starting the WebSphere Commerce Payments
application server and you must issue the StopIBMPayServer command before
stopping the WebSphere Commerce Payments application server.

Opening the WebSphere Commerce Administration Console

TheWebSphere Commerce Administration Console allows you to control your
site or store by completing administrative operations and configuration tasks.
If you are authorized to work with multiple stores and languages, you select
the store and language with which you want to work when you log on to the
Administration Console. The tasks that you are authorized to perform display
on the Administration Console home page through various menus. These
tasks are based on the user group names (roles) and authority levels.

The WebSphere Commerce Administration Console is not accessible from the
browser that is part of WebSphere Studio Application Developer. To open the
WebSphere Commerce Administration Console, do the following:

1. Ensure that WebSphere Commerce - Express is started. For instructions on
starting WebSphere Commerce - Express, refer to [‘Starting WebSphere|
[Commerce - Express” on page 72|

2. Open Internet Explorer and access the following URL:

https://hostname/webapp/wcs/admin/serviet/
ToolsLogon?XMLFile=adminconsole.AdminConsolelLogon

where hostname is the fully-qualified TCP/IP host name of the WebSphere
Commerce - Express Developer Edition machine.

The URL is shown on multiple lines for display purposes only. Enter the
URL as a single line.

Opening the WebSphere Commerce Organization Administration Console

The WebSphere Commerce Organization Administration Console allows you,
and the buyer’s administrators to control the organizations that access your
site or store. The tasks that you are authorized to perform display on the
Organization Administration Console home page through various menus.
These tasks are based on the user roles and authority levels.
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The WebSphere Commerce Organization Administration Console is not
accessible from the browser that is part of WebSphere Studio Application
Developer. To open WebSphere Commerce Organization Administration
Console, do the following:

1. Ensure that WebSphere Commerce - Express is started. For instructions on
starting WebSphere Commerce - Express, refer to [‘Starting WebSphere|
[Commerce - Express” on page 72|

2. Open Internet Explorer and access the following URL:

https://hostname/webapp/wcs/orgadmin/serviet/
ToolsLogon?XMLFile=buyerconsole.BuyAdminConsolelLogon

where hostname is the fully-qualified TCP/IP host name of the WebSphere
Commerce - Express Developer Edition machine.

The URL is shown on multiple lines for display purposes only. Enter the
URL as a single line.

Opening the WebSphere Commerce Accelerator

The WebSphere Commerce Accelerator allows you to maintain online stores
by completing various store operations — from managing the look and feel of
your store to creating and maintaining orders to tracking store activities.

The WebSphere Commerce Accelerator is not accessible from the browser that

is part of WebSphere Studio Application Developer. To open WebSphere

Commerce Accelerator, do the following:

1. Ensure that WebSphere Commerce - Express is started. For instructions on
starting WebSphere Commerce - Express, refer to [‘Starting WebSphere|
Commerce - Express” on page 72

2. Open Internet Explorer and access the following URL:

https://hostname/webapp/wcs/tools/serviet/
ToolsLogon?XMLFi1le=common.mcLogon

where hostname is the fully-qualified TCP/IP host name of the WebSphere
Commerce - Express Developer Edition machine.

The URL is shown on multiple lines for display purposes only. Enter the
URL as a single line.

Opening the WebSphere Commerce Payments user interface

While much of the WebSphere Commerce Payments user interface is
incorporated into the other WebSphere Commerce tools, you may want to
open the WebSphere Commerce Payments user interface on its own.
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The WebSphere Commerce Payments user interface is not accessible from the
browser that is part of WebSphere Studio Application Developer. To open the
WebSphere Commerce Payments user interface, do the following;:

1. Ensure that WebSphere Commerce Payments is started. For instructions on
starting WebSphere Commerce Payments, refer to |[“Starting WebSphere]
[Commerce Payments” on page 73

2. Open Internet Explorer and access the following URL:
http://hostname:9081/webapp/PaymentManager

Log on using the WebSphere Commerce Site Administrator ID and
password.

Enabling the administration console

Enabling the administration console for the WebSphere Commerce - Express
application server allows you to use the WebSphere Application Server
Administrative Console to configure the WebSphere Commerce - Express
application server in the WebSphere test environment.

To enable the administration console for the WebSphere Commerce - Express
application server, do the following:

1. Start WebSphere Commerce - Express Developer Edition by selecting Start
> Programs » IBM WebSphere Commerce - Express Developer Edition »
WebSphere Commerce development environment.

2. In the Servers view, double-click WebSphereCommerceServer. The
WebSphereCommerceServer view displays.

3. In the WebSphereCommerceServer view, select the Configuration page.

4. On the Configuration page, select the Enable administration console
check box.

5. Save the updates to the configuration by selecting File » Save
WebSphereCommerceServer.

6. Republish the server by going to the Servers view, right-clicking
WebSphereCommerceServer, and selecting Publish from the pop-up menu.
Click OK.

Starting the administration console

Before you can start the administration console, it must be enabled in the
WebSphere Commerce - Express application server. For instructions on
enabling the administration console in the WebSphere Commerce - Express
application server, refer to [“Enabling the administration console.”]

To start the administration console for the WebSphere Commerce - Express
application server, do the following:
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1.

If WebSphere Commerce - Express was running when you enabled the
administration console, stop WebSphere Commerce - Express as described
in [“Stopping WebSphere Commerce - Express” on page 73]

Start WebSphere Commerce - Express according to the instructions in
[‘Starting WebSphere Commerce - Express” on page 72

When WebSphere Commerce - Express has successfully started, go to the
Servers view, right-click WebSphereCommerceServer, and select Run
administrative client from the pop-up menu.

The administration console will appear in the Admin Console view.

Importing a project manually

If, during the import of the WebSphere Commerce - Express Developer
Edition workspace, a project fails to import, do the following:

1.

Start WebSphere Commerce - Express Developer Edition by selecting Start
+ IBM WebSphere Commerce - Express Developer Edition »+ WebSphere
Commerce development environment.

Ensure you are in the J2EE perspective. If you cannot find the J2EE
perspective, select Window » Open Perspective » J2EE.

Go to the Project Navigator view.
Delete the project that failed to import by doing the following:

a. Right-click the project that failed to import and select Delete from the
pop-up menu. The Delete Module Options dialog displays.

b. In the Delete Module Options dialog, ensure that Delete selected
project(s) only is selected and click OK. The Confirm Project Delete
dialog displays.

C. In the Confirm Project Delete dialog, ensure that Do not delete
contents is selected and click Yes.

Import the project into the workspace by doing the following:

a. Select File » Import. The Import wizard starts.

b. Select Existing Project into Workspace and click Next.

C. On the Import Project page of the wizard, click Browse.

d

. In the Browse for Folder dialog, locate the folder with the same name
as the project that failed to import. Select the folder and click OK to
dismiss the dialog.

The folders for projects are located in the WebSphere Commerce -
Express Developer Edition workspace directory. The default workspace
directory is C:\WebSphere\workspace_db2.

e. Click Finish.
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If the Repair Server Configuration dialog displays after clicking Finish,
ensure that WebSphereCommerceServer configuration and any entries
below it are selected and click OK.

If multiple projects failed to import, repeat these steps for each project.
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Appendix B. Recovering from installation errors

This section contains information describing how to recover from error
messages received from the WebSphere Commerce - Express Developer
Edition installation wizard.

Merchant key is invalid

If you receive an error message indicating that the merchant key entered is
invalid, ensure that you have entered the merchant key correctly and that the
merchant key meets all the criteria listed in [“Other information required to|
fcomplete the installation wizard” on page 16,

Importing the WebSphere Commerce - Express Developer Edition workspace
fails
If importing the WebSphere Commerce - Express Developer Edition
workspace into WebSphere Studio Application Developer fails, check if the

WebSphere Commerce - Express Developer Edition workspace import log
exists. The workspace import log file is located in the following path:

WCDE_installdir\logs\import_workspace.log

The default value for WCDE_installdir is listed 'ml”Path variables” on page V.I

If the workspace import log file does not exist, do the following;:
1. Ensure that WebSphere Studio Application Developer is not running.

2. Delete the .metadata directory from WCDE_workspacedir. Default values
for WCDE_workspacedir are listed in |“Path variables” on page v

3. Start a command prompt session by selecting Start + Programs -
Accessories » Command Prompt.

4. Issue the following command:
WCDE_installdir\Commerce\bin\import_workspace.bat

5. After the command finishes, check the workspace import log file to ensure
that all projects were imported successfully. If any exceptions occurred
while a project was being imported, then that project must be imported
manually. Refer to [“Importing a project manually” on page 8()| for
instructions on importing a project manually.

If the workspace import log file exists, follow the instructions in |”WebSphera
[Commerce - Express Developer Edition workspace import log” on page 34
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WebSphere Commerce - Express Developer Edition instance creation fails

If the creation of the WebSphere Commerce - Express Developer Edition
instance fails during the installation, check if the instance directory exists. The
instance directory is:

WCDE_installdir\Commerce\instances\instance_name

where instance_name is the name of the WebSphere Commerce - Express
Developer Edition instance. The default name of the WebSphere Commerce -
Express Developer Edition instance is Demo_Dev and the default value for
WCDE_installdir is listed in [“Path variables” on page v.|

If the instance directory exists, do the following:

1. Check the instance creation log files listed in [“WebSphere Commerce -|
[Express Developer Edition instance creation logs” on page 35| to confirm
that instance creation failed.

2. If the log files confirm that instance creation failed, do the following:

a. Drop the WebSphere Commerce - Express Developer Edition database
by following the instructions in [“Dropping a database” on page 68

b. Create the WebSphere Commerce - Express Developer Edition instance
manually by following the instructions in [’Creating a WebSphere|
[Commerce - Express Developer Edition instance” on page 63

If the instance directory does not exist, create the WebSphere Commerce -
Express Developer Edition instance manually by following the instructions in
“Creating a WebSphere Commerce - Express Developer Edition instance” on|

page 63.|
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Appendix C. Known problems and limitations

This section covers known problems and limitations with WebSphere
Commerce - Express Developer Edition. Refer to the README file for any
updates on problems or limitations.

Installation problems and limitations

User authorization

You should log on as a user with Administration rights before beginning the
WebSphere Commerce - Express Developer Edition installation.

Windows Installer Internal Error 20552

If you receive error 20552 during WebSphere Studio Application Developer
installation phase of the WebSphere Commerce - Express Developer Edition
installation, check if you have a Web server or WebSphere Application Server
running. If either of these applications are running, shut them down.

Problems starting WebSphere Commerce - Express in the WebSphere test
environment
If you are experiencing problems starting WebSphere Commerce - Express in

the WebSphere test environment, do the following in WebSphere Commerce -
Express Developer Edition:

1. Start WebSphere Commerce - Express Developer Edition by selecting Start
» Programs » IBM WebSphere Commerce - Express Developer Edition »
WebSphere Commerce development environment.

2. Select Window » Preferences. The Preferences window displays.

3. Select Workbench and clear the Perform™ build automatically on
resource modification check box. Click Apply.

4. Select Validation and clear the following check boxes:
* HTML Syntax Validator
* JSP Compilation Validator
* WAR Validator
5. Click Apply.
6. Restart WebSphere Commerce - Express Developer Edition.

7. Start the WebSphere Commerce - Express Server. For instructions, refer to
[‘Starting WebSphere Commerce - Express” on page 72|
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WebSphere Commerce - Express Developer Edition and WebSphere Commerce -
Express coexistence

If you plan to install WebSphere Commerce - Express Developer Edition and
WebSphere Commerce - Express on the same machine, they must not share
any assets. Each product should use their own database and their own
instance. The following table shows the default names of the databases and
instances for WebSphere Commerce - Express Developer Edition and
WebSphere Commerce - Express:

WebSphere Commerce - Express Developer | WebSphere Commerce
Edition - Express

Commerce
database Demo_Dev Mall
name
Payments
database wpm wpm
name
Instance

Demo_Dev Demo
name

If the wpm database exists during the installation of WebSphere Commerce -
Express Developer Edition, you must specify a different database user ID for
the new wpm database. If you use the same database user ID for both wpm
databases the creation of the WebSphere Commerce Payments instance for
WebSphere Commerce - Express Developer Edition will fail. The WebSphere
Commerce Payments instance can be created manually after installing
WebSphere Commerce - Express Developer Edition by following the
instructions in |“Creating a WebSphere Commerce Payments instance” on page|

— Important
In a coexistence environment, WebSphere Commerce - Express and
WebSphere Commerce - Express Developer Edition cannot be running at
the same time.

If you want to use WebSphere Commerce - Express Developer Edition,
ensure the following applications are stopped:

* Web server
* WebSphere Commerce - Express application server
* WebSphere Commerce Payments application server

If you want to use WebSphere Commerce - Express, ensure that
WebSphere Commerce - Express Developer Edition is not running.
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Appendix D. Uninstalling WebSphere Commerce - Express
Developer Edition

If you encounter problems installing WebSphere Commerce - Express
Developer Edition, you may want to uninstall one or more components and
start again. This chapter explains how to uninstall each component of
WebSphere Commerce - Express Developer Edition.

Uninstalling WebSphere Commerce - Express Developer Edition

Uninstalling WebSphere Commerce - Express Developer Edition removes the
WebSphere Commerce - Express Developer Edition workspace from
WebSphere Studio Application Developer. WebSphere Studio Application
Developer and DB2 Universal Database are not uninstalled when uninstalling
WebSphere Commerce - Express Developer Edition.

To uninstall WebSphere Commerce - Express Developer Edition, complete the
following steps:

1. While logged on with a Windows user ID with Administrator authority,
click Start » Settings » Control Panel + Add/Remove Programs.

2. Click Change or Remove Programs, select IBM WebSphere Commerce -
Express Developer and click Change/Remove.

3. A window opens asking you to confirm that you want to remove the
selected programs. Click Yes to continue with the uninstall.

4. When the uninstall is complete, click OK.

5. Remove the WebSphere Commerce - Express Developer Edition path from
the Path environment variable by doing the following:

a. Select Start » Settings + Control Panel » System. The System
Properties dialog opens.

b. Select the Advanced tab of the System Properties dialog.

c. Click Environment Variables. The Environment Variables window
opens.

d. In the System variables pane, scroll the list of variables so you can
select the Path environment variable.

e. After selecting the Path environment variable, click Edit.

f. In the Variable Value field, remove any paths containing the
WebSphere Commerce - Express Developer Edition installation
directory. For example, C: \WEBSP~1\COMMER™~1\Commerce\bin.
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The default WebSphere Commerce - Express Developer Edition
installation directory is C:\WebSphere\CommerceDev55, which may appear
as C:\WEBSP~1\COMMER™1 when part of a path in the Path environment
variable.

6. Remove the following directories:

e WCDE installdir where the default value for WCDE_installdir is listed in
[“Path variables” on page v

* The WebSphere Commerce - Express Developer Edition workspace
directory. The default workspace directory is
C:\WebSphere\workspace_db2.

If you receive a sharing violation error when removing the following
directories, try stopping all DB2 Universal Database processes before
trying to remove the directories again.

Uninstalling WebSphere Studio Application Developer

Before uninstalling WebSphere Studio Application Developer, uninstall
WebSphere Commerce - Express Developer Edition by following the
instructions in [“Uninstalling WebSphere Commerce - Express Developer|
[Edition” on page 87

To uninstall WebSphere Studio Application Developer, complete the following
steps:

1. While logged on with a Windows user ID with Administrator authority,
select Start » Settings + Control Panel + Add/Remove Programs.

2. Click Change or Remove Programs, select IBM WebSphere Studio
Application Developer 5.1 and click Change/Remove.

The uninstall wizard starts.
3. Complete the uninstall wizard by following the prompts.
4. When the uninstall is complete, restart your machine.
5. Delete the following directories:

* WSAD_installdir

where the default value for WSAD_installdir is listed in [“Path variables”]

on page v.

Uninstalling DB2 Universal Database

Before uninstalling DB2 Universal Database, uninstall WebSphere Commerce -
Express Developer Edition by following the instructions in |”Uninsta11in§|
[WebSphere Commerce - Express Developer Edition” on page 87

To uninstall DB2 Universal Database complete the following steps:
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. Drop your WebSphere Commerce - Express Developer Edition database. To
drop the database, do the following:

a.

Start a DB2 command line session by selecting Start + Program Files »
IBM DB2 » Command Line Tools * Command Window.

Check the name of the WebSphere Commerce - Express Developer
Edition database by issuing the following command in the DB2
command line session:

1ist db directory

This command lists all databases defined.
Issue the following command:
drop db db_name

where db_name is the name of your WebSphere Commerce - Express
Developer Edition database.

. Select Start » Settings » Control Panel + Add/Remove Programs.

. Click Change or Remove Programs, select DB2 Universal
Database Express Edition and click Remove.

. A confirmation window opens asking you to confirm the uninstall. Click
Yes.

. Delete the DB2 installdir directory. The default value for DB2_installdir is
listed in [“Path variables” on page v|

. Restart your machine.
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Appendix E. Where to find more information

More information about the WebSphere Commerce - Express Developer
Edition system and its components is available from a variety of sources in
different formats. The following sections indicate what information is
available and how to access it.

WebSphere Commerce - Express Developer Edition information

The following are the sources of WebSphere Commerce - Express Developer
Edition information:

* ["WebSphere Commerce - Express Developer Edition online help”|

* ["WebSphere Commerce - Express Web site” on page 92|

* ["WebSphere Developer Domain” on page 92|
* ["'IBM Redbooks ” on page 92|

WebSphere Commerce - Express Developer Edition online help
The WebSphere Commerce - Express Developer Edition online information is
your primary source of information for creating and publishing stores in
WebSphere Commerce - Express Developer Edition.

To view the WebSphere Commerce - Express Developer Edition online help,
do the following:

1. Start WebSphere Commerce - Express Developer Edition by selecting Start
> Programs » IBM WebSphere Commerce - Express Developer Edition »
WebSphere Commerce development environment.

2. From the Help menu, select Help Contents.

Note: If you refer to instructions for multiple platforms in the |”WebSpherE|
[Commerce - Express Developer Edition online help,”| ensure you follow
the instructions for WebSphere Commerce - Express Developer Edition.
When a help page contains information for multiple platforms,
information specific to WebSphere Commerce - Express Developer
Edition is indicated with the following icon:

Developer

If information specific to WebSphere Commerce - Express Developer
Edition is not available, ensure you follow instructions specific to
Windows, When a help page contains instructions for multiple
platforms, instructions for Windows are indicated with the following
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icon:

WebSphere Commerce - Express Web site

WebSphere Commerce - Express Developer Edition product information is
available at the WebSphere Commerce - Express Web site. Refer to the
following URLs for more product information:

[nttp://www.ibm.com/software/webservers/commerce/1ibrary/|

WebSphere Developer Domain

Additional information on WebSphere Commerce - Express Developer Edition
and WebSphere Commerce - Express is also available in the WebSphere
Commerce - Express Zone at WebSphere Developer Domain:

|nttp://www.ibm.com/websphere/developer/zones/commerce/|

IBM Redbooks™

WebSphere Commerce - Express Developer Edition and WebSphere Commerce
- Express information is available at the IBM Redbooks Web site:

[http://www.ibm.com/redbooks|

WebSphere Studio Application Developer information

The following are sources of information for WebSphere Studio Application
Developer:

* ["WebSphere Studio Application Developer online help”|

* ["WebSphere Studio Application Developer Web site”|

* ["“WebSphere Developer Domain” on page 93|
* ["IBM Redbooks” on page 93|

WebSphere Studio Application Developer online help

The WebSphere Studio Application Developer online help is your primary
source of information on how to perform tasks within WebSphere Studio
Application Developer.

To view the WebSphere Studio Application Developer online help, do the
following:

1. Start WebSphere Commerce - Express Developer Edition by selecting Start
+ Programs » IBM WebSphere Studio » Application Developer 5.1.

2. From the Help menu, select Help Contents.

WebSphere Studio Application Developer Web site

WebSphere Studio Application Developer product information is available on
the WebSphere Studio Application Developer Web site:

|nttp://www.ibm.com/software/ad/studioappdev/1ibrary/|
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WebSphere Developer Domain
Additional information on WebSphere Studio Application Developer is
available on the WebSphere Studio Application Developer page of the
WebSphere Studio Zone of WebSphere Developer Domain:

[http://www.ibm.com/websphere/developer/zones/studio/appdev/|

IBM Redbooks

WebSphere Studio Application Developer information is available at the IBM
Redbooks Web site:

[http://www.ibm.com/redbooks|
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Notices

This information was developed for products and services offered in the
US.A.

IBM may not offer the products, services, or features discussed in this
document in other countries. Consult your local IBM representative for
information on the products and services currently available in your area. Any
reference to an IBM product, program, or service is not intended to state or
imply that only that IBM product, program, or service may be used. Any
functionally equivalent product, program, or service that does not infringe
any IBM intellectual property right may be used instead. However, it is the
user’s responsibility to evaluate and verify the operation of any non-IBM
product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give
you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the
IBM Intellectual Property Department in your country or send inquiries, in
writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY
OR FITNESS FOR A PARTICULAR PURPOSE.
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Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will
be incorporated in new editions of the publication. IBM may make
improvements and/or changes in the product(s) and/or the program(s)
described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those
Web sites. The materials at those Web sites are not part of the materials for
this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the
purpose of enabling: (i) the exchange of information between independently
created programs and other programs (including this one) and (ii) the mutual
use of the information which has been exchanged, should contact:

IBM Canada Ltd.

Office of the Lab Director
8200 Warden Avenue
Markham, Ontario

L6G 1C7

Canada

Such information may be available, subject to appropriate terms and
conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer
Agreement, IBM International Program License Agreement or any equivalent
agreement between us.

Trademarks

The IBM logo and the following terms are trademarks or registered
trademarks of International Business Machines Corporation in the United
States or other countries or both:

DB2 DB2 Universal Database IBM
iSeries MQSeries Redbooks
WebSphere
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Solaris, Java and all Java-based trademarks and logos are trademarks or
registered trademarks of Sun Microsystems, Inc. in the United States, other
countries, or both.

Microsoft and Windows are trademarks or registered trademarks of Microsoft
Corporation in the United States, other countries, or both.

Pentium is a registered trademark of Intel Corporation in the United States,
other countries, or both.

Other company, product and service names may be trademarks or service
marks of others.
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